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Overview

This section discusses the following topics:
e  When to Use the DeviceMaster NS-Link Device Driver
e Comtrol Drivers Management Console

¢  Supported Operating Systems

e  Products Supported

e (Conventions on Page 6
* Downloading the Latest Software and User Guides on Page 7

When to Use the DeviceMaster NS-Link Device Driver

Install the DeviceMaster NS-Link device driver to use DeviceMaster serial ports
as native COM ports and to set up secure COM ports. If you install the device
driver, you can also configure the ports for socket mode or serial tunneling. See
NS-Link Device Driver Configuration Considerations on Page 29 for detailed
information about the NS-Link device driver.

Comtrol Drivers Management Console

This User Guide discusses how to install and configure Comtrol device drivers
using the Installation Setup Wizard and the Comirol Drivers Management Console
for the NS-Link device driver.

The Comtrol Drivers Management Console is accessible through the Windows
Control Panel using a dedicated shortcut created during the initial device driver
installation process. The Comtrol Drivers Management Console allows you to
browse all installed and supported Comtrol products in one place and apply any
changes quickly.

Note: This User Guide discusses the DeviceMaster, see the RocketPort EXPRESS/
INFINITY, RocketPort and RocketModem (Universal PCI) Series User
Guide for Windows for adapter specific information.

You can refer to Using the Comirol Drivers Management Console on Page 31 for
general information about the Comtrol Drivers Management Console.

Supported Operating Systems

The Comtrol Drivers Management Console supports the following operating

systems:

e  Windows 8

e  Windows Server 2012
e  Windows 7

e  Windows Server 2008
e Windows Vista

DeviceMaster Driver User Guide: 2000531 Rev. E Overview - 5



Overview

e  Windows Server 2003
e  Windows XP

Products Supported

These are the products supported by the Comtrol Drivers Management Console:
e DeviceMaster LT

e DeviceMaster PRO

¢ DeviceMaster RTS

e DeviceMaster Serial Hub

e DeviceMaster 500

¢ RocketModem IV

¢ RocketPort EXPRESS

¢ RocketPort EXPRESS SMPTE

¢ RocketPort INFINITY

¢ RocketPort Plus Universal PCI

¢  RocketPort Plus/422 Universal PCI
¢ RocketPort Universal PCI

¢ RocketPort Universal PCI SMPTE

Conventions

In the remainder of this User Guide, the products are referred to accordingly:
¢ Comtrol device unless there is model-specific information

¢ DeviceMaster means the DeviceMaster models listed in the previous
subsection

¢ RocketPort means any RocketPort model

¢ RocketPort EXPRESS/INFINITY means RocketPort EXPRESS, RocketPort
EXPRESS SMPTE, and RocketPort INFINITY

¢ RocketPort and RocketModem (Universal PCI) means RocketModem IV,
RocketPort Universal PCI, RocketPort Plus Universal PCI, RocketPort Plus/
422 Universal PCI, and RocketPort Universal PCI SMPTE

The paths in this Guide to locate DeviceMaster software and documentation point
to the DeviceMaster RTS paths on the ftp site. All supported DeviceMasters
(Products Supported) models use the same software and documentation.

6 - Products Supported DeviceMaster Driver User Guide: 2000531 Rev. E
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Downloading the Latest Software and User Guides

You can use the CD or the following table to locate the latest version of the
software and documentation.

Software Description Document
Install on a Windows host to
program the IP address and manage
your DeviceMaster.
g - PortVision DX supports:
=20 ¢  Windows 8
“.H . .
ag PortVision DX *  Windows Server 2012
= '—';' ) e Windows 7
§& *  Windows Server 2008
© ¢ Windows Vista
¢ Windows Server 2003
e Windows XP wh
Bootloader is the operating system |DeviceMaster
that runs on the DeviceMaster Installation
hardware during the power on and
Bootloader phase, which then loads Configuration
W SocketServer. Guide
o Update the Bootloader on your
g DeviceMaster, if advised by
g Technical Support.
E SocketServer is the name of the TCP/
i IP socket web page that is integrated
in the firmware that comes pre-
SocketServer installed on your DeviceMaster.
o Note: Make sure you upload the
latest version of SocketServer
before configuring the device
driver.
. Windows 8
Windows Server 2012
E Windows 7 Install if you want COM ports
S Windows Server 2008 (native or secure).
o Windows Vista Existing customers may want to &
9 W}ndows Server 2003 | refer to Existing Installations on This Guid
2 Windows XP Page 9. (This Guide)
R o,
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Before Installing the Comtrol Drivers
Management Console

This section provides an overview for the procedures that you may need to perform
before installing the Comtrol Drivers Management Console for the device driver.

This section contains the following discussions:
e  FExisting Installations

e Initial Installation Overview on Page 11

e Install the Hardware on Page 11

e Install PortVision DX on Page 11

e  Program the IP Address (Network Information) on Page 13
e  Uploading SocketServer on Page 16

Existing Installations

Review the information below if you have an existing installation that predates
these versions:

e NS-Link Driver before V9.02 or SocketServer Before V8.00
e Installations Before v10.xx on Page 10

NS-Link Driver If you are familiar with the NS-Link device driver, you will be pleasantly surprised
before V9.02 or to find that NS-Link driver configuration is now handled in an easy to use
SocketServer Before Management Console. In addition, if you are comfortable with using the Device
V8.00 Manager configuration method, you can still configure the driver without

changing your installation routine.

Previous to the NS-Link driver v9.02 and SocketServer v8.00, there were two
versions of firmware that ran on the DeviceMaster, SocketServer and NS-Link.

With the release of v9.02 of the NS-Link driver, SocketServer and NS-Link have
been incorporated into a single binary (.bin) file.

By default, once loaded, SocketServer shows in both the web page and PortVision
DX until the NS-Link device driver begins communication with this particular
DeviceMaster. Once a driver establishes communications, the firmware indicates
that it is NS-Link. The driver does not need to upload firmware to the
DeviceMaster or reboot the DeviceMaster.

If SocketServer does not change to NS-Link in the web page and PortVision DX,
then the NS-Link device driver loaded in the PC/laptop is NOT communicating
with the DeviceMaster.

Note: Comtrol recommends uploading the latest version of SocketServer before
configuring the driver.

You can use PortVision DX to determine your SocketServer or NS-Link versions
(Page 15).
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Before Installing the Comtrol Drivers Management Console

1PV PortVision DX
File Manage View Tools Help

. A Z ~~

= &% % H o 8 8

= R
> 0 =

Help  About Bt

Scan  Refresh J : totes
e

S B v ES9528-XT [11/11]

-l v ESTS06[0/1]

IPORTVIS < B 500
(ﬁ%ﬁ) B ES7510-XT

) 4 ESES08F-M
Name : First Floor - o [ 4 ESBS09-XT
. [ & ES8510
B+ ES8510-XT
B ES8510-XTE
1 + 10-Link Master #1
-8 + EtherNet/IP System
-B v LTI622
Use menu or toolbar to add notesin -« -B + Modbus Router System
ks B+ Modbus/TCP
[ B+ PROB Console Port COM Ports [0 /1]
B+ RTS2-Port
-8 + RTS4 Spare COM Ports
-8 + SH8 Console Port COM Ports

m

NS-Link indicates that the driver for Windows has been
installed and configured. The version number reflects
the underlying SocketServer version. SocketServer is
the default DeviceMaster application.

| IP Address | MAC Address | 4 Software Version ‘ Status

+ | | Device Name | Model
B EtheNet/IP System UP-1P (5-30V)
B Modbus/TCP UP-1P (3V)

E|| B« Modbus Router System UP-4P (DEQ)

B« SHS Console Port COM Ports SH-8P (DB9)

1921681155  00:C0:4E:21:05:CD EtherNet/IP 410 ON-LINE
1921681153 00:C0:4E15:04:7A EtherNet/IP 410 ON-LINE
1921681154 00:C0:4E:07:43:34 Modbus Router 510 ON-LINE
1921681114 00 F:FD /NS-Link 9.18 ON-LINE

B ' (& PRO3 Console Port COM Ports ~ PRO-GP (DB9) 19216811.20  00:CO4EAT:FR:FB | NS-Link 9.18 ON-LINE
By L7622 DM-LT16 1921681161  00:CO:4E:40:FF:FO | NS-Link9.231 ON-LINE
B RTH Spare COM Ports RTS-4P (DBY) 19216811.23  00:C0:AE:07:FF:FC | SocketServer 9.18 ON-LINE
B RTS2-Port RTS-2P (2E) 192.168.11.52  00:C0:4E:29:FF:F5 \SocketServer 9.18 ON-LINE
-||Bv  ES9528-XT ES9528-KT 19216811105 00:C0:4E:36:00:02 14 (b11.04) ON-LINE
4 L1} L3
For Help, press F1 First Floor 9 |0 [Ready
Installations Before When upgrading NS-Link drivers before v10.xx you must remove the existing
v10.xx driver and re-install the latest driver.

Note: If you are unsure about the driver version, refer to Checking the Device

Driver Version on Page 22.

You can use this procedure to upgrade from a 9.xx driver to 10.xx drivers.

1. Optionally, you can save your existing NS-Link device and COM port
configuration to a configuration file that you can upload to the device and to
individual ports after installing the 10.xx driver.

Remove the existing NS-Link driver.
Reboot the system as prompted.

A A

If necessary, check the SocketServer version and upload the latest version.
If necessary, upload Bootloader to v3.23 or higher. You can use PortVision DX

to upload the Bootloader. The procedure for uploading Bootloader is the same

procedure as uploading SocketServer.

6. Install the latest NS-Link driver by executing the

DeviceMaster Windows_x.xx.exe file.

7. Associate the MAC address to the DeviceMaster, if required, configure IP
mode, and configure the device properties or optionally, upload the device

properties from the configuration file.

8. Configure the port properties or optionally, upload the COM port properties,

port-by-port. The port properties must

uploaded on a port-by-port basis.

10 - Installations Before v10.xx
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Before Installing the Comtrol Drivers Management Console

Initial Installation Overview

If you have already performed the following procedures, you can skip to the next
section, NS-Link Device Driver Installation on Page 17.

You may also refer to the DeviceMaster Installation and Configuration Guide,
which provides detailed information about the following procedures:

1. Install the hardware (below).

2. Install PortVision DX (below).

3. Program the network information using PortVision DX (Page 13).
4

Check the SocketServer version and determine whether you need to download
an updated version (Page 15).

5. Ifnecessary, upload the latest version of SocketServer (Page 16).

Install the Hardware

If you have not done so, install the DeviceMaster:

1. Connect an Ethernet cable between the DeviceMaster and a host PC NIC or to
the same Ethernet network segment using a standard Ethernet cable. Refer to
Connectivity Requirements on Page 68 for cabling information.

2. Connect the power supply or cable to the DeviceMaster and apply power.

3. Check the DeviceMaster LEDs to verify that it is ready. Refer to DeviceMaster
LEDs on Page 70 to determine the LED status.

Install PortVision DX

PortVision DX automatically detects Comtrol Ethernet attached products
physically attached to the local network segment so that you can configure the
network address, upload firmware, and manage the following products:

¢ DeviceMaster family
- DeviceMaster LT
- DeviceMaster PRO
- DeviceMaster RTS
- DeviceMaster Serial Hub
- DeviceMaster UP
- DeviceMaster 500
e JO-Link Master
¢ RocketLinx

PortVision DX replaces PortVision Plus. PortVision Plus does not support
operating systems above Windows 7 and SocketServer versions above v9.00 or NS-
Link device driver v10.xx.

PortVision DX may require that you have the latest Microsoft Service pack for
your operating system:

e Windows 8
e  Windows Server 2012
e  Windows 7

e  Windows Server 2008

DeviceMaster Driver User Guide: 2000531 Rev. E Initial Installation Overview - 11



Before Installing the Comtrol Drivers Management Console

Windows Vista
Windows Server 2003
Windows XP

In addition to identifying Comtrol Ethernet attached products, you can use
PortVision DX to display any third-party switch and hardware that may be
connected directly to those devices. All non-Comtrol products and unmanaged
RocketLinx devices are treated as non-intelligent devices and have limited feature
supp(ﬂ't. For example, you cannot configure or update firmware on a third-party
switch.

Use the following procedure to install PortVision DX.

1.
2.

Download PortVision DX from ftp:/ftp.

comtrol.com/dev_mstr/portvision dx.

Execute the PortVision_DX_[version].msi file and follow the Installation

wizard.

Click Launch PortVision DX and Finish in the last installation screen.

Click Scan so that PortVision DX
locates the DeviceMaster.

PortVision DX displays the Comtrol
Ethernet attached products for
which you chose to scan. See the
PortVision DX help system detailed
information about how to use it to
tailor your view.

Go to the next discussion to program
the network information into the
DeviceMaster.

You can save time if you only scan for
DeviceMasters.

Scan Network @
Select any number of device types from the list below and dick Scan to start
scanning the network.
[ DeviceMaster 500 f AIR /LT /PRO /RTS { Serial Hub [ UP
[V 10-Link Master
¥ Rocketiinx (Managed Only)
Note: If you want to abort the process, dick Cancel,
Cancel

IPY PortVision DX

| A~
=

Scan Refresh

File Manage View Tools

Help
o~
S -
- > > o e € <& -
erfies  Save | Notes Help

=3 [foE =5

0 =

About Exit

IPORTVIS&%;

== <———— The conte

MName : First Floor

this area.

Use menu or toolbar to add notesin -~ «

nts of this folder are displayed in the Device Lisfpane -~

< [0

For Help, press F1

-l v ES8528-XT [11/11] (below).
[ Wl v EST30610/1]
B “: Egig - See the PortVision DX help system for procedures on organizing
= : Eng' your devices and customizing your view or views in PortVision DX
[ ESBS08
B+ ESE508F-M
a o[l ESBS09-XT L
[ o ESB510 I
[ ESBSL0-XT
B+ ES8510-XTE
e | % 10-Link Master #1
! . B o EtherNet/IP System
- B LTIG#2
B+ Modbus Router System
. W o Modbus/TCP
[~ + PROS Console Port COM Ports [0 /1]
B« RTS2-Port [lavice free Fane
s B+ RTS4 Spare COM Ports
.. Th & SH8 Console Port COM Ports -
» | | Device Name | Model |IP Address MAC Address | 4 Software Version | Status
B Etheret/IP System UP-1P (5-30V) 1921681155  00:COAEZ1:05:CD Etherhet/IP 410 ON-LINE
B Modbus/TCP UP-IP(5V) 1921681153  00:COAELS:04TA EtherNet/IP 4.10 ON-LINE
El||B v Modbus Router System UP-4P (DBY) 1921681154  00:CO:AE07:4384 Modbus Router 500 OM-LINE
B SHEConsolePort COMPorts  SH-8P(DBS) 1921681114  QO:COMEICFRFD NS-Link918 ON-LINE
B & PRO8 Conscle Port COM Ports ~ PRO-8P (DB9) 1921681120  O0:COMELT:FRFE NS-Link918 ON-LINE
By LTI6E2 DM-LTL6 1921681161  00:COME40:FRF0 NS-Link9.23.1 ON-LINE
B RTS4 Spare COM Ports RTS-4P (DB9) 1921681123  00:COAEQT:FFFC SocketServer 918 M-
B RIS2Port RTS2P(E) 1921681150 OR:COME20:FFFS SocketServerdas Remole
~||@v Es9s28-XT ESE528-XT 19216811105 00:CO:4E:36:00:02 V14 (b11.0.4) ON-LINE Device
: Device Lisf Pane
First Floor 9 [0 |Ready

12 - Install PortVision DX
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Before Installing the Comtrol Drivers Management Console

Program the IP Address (Network Information)

If you have not done so, program the IP address for your network. The following
procedure is to program a single DeviceMaster, if you want to program IP
addresses into multiple DeviceMasters, refer to the PortVision DX help system or
the_DeviceMaster Installation and Configuration Guide.

1. If necessary, start PortVision DX, Start > Programs > Comtrol > PortVision DX >
PortVision DX.

2. Ifthe DeviceMaster that you want to program is not displayed, click Scan.

3. Right-click the DeviceMaster in the Device Tree or Device List pane for which
you want to program network information and click Properties.

Note: Optionally, you can double-click the DeviceMaster and PortVision DX
opens the Properties page.

1B PortVision DX [E=BEER ===

File Manage View Tools Help

TS = A 4 o 8 8 8 - 0

Scan Refresh | Properties  Save load  Upload Reboot Webpage Notes Help About Exit
B~ [Z=] First Floor [9/9] -
- B v ES9528-XT[11/11]

B~ ESTS06[0/1]
* EST510

* EST510-XT

- ES7528

- ES8508

* ESE508F-M

* ESE509-XT

* ES8510

* ES8510-XT
B+ ES8510-XTE
1+ 10-Link Ma:
* Etherlet/IP Syster
. LT16 22 Delete

* Modbus Router Sy —

* Modbus/TCP

* PROE Console Por
¢ RTS 2-Port SR Device Tree Pane
* RTS4 Spare COM F
* SH8 Console Port

IPORTVIS&%;

Mame : First Floor I

n

Rename

Move

Use menu or toolbar to add notes in -
this area.

Webpage
Telnet / S5H Session

MAC Address | 4 Software Version | Status
Advanced > 4E-

B EtherNet/IP System EtherNet/IP 410 ON-LINE

B+  Modbus/TCP Cenfiguration ¢ : 15:04:7TA  EtherNet/IP 410 ON-LINE
B+ Modbus Router System Tracker » : 43:84 Modbus Router 510 ON-LINE
B+ 5HS Console Port COM Ports - :FD NS-Link 9.18 ON-LINE
B + & PRO8 Console Port COM Por Help ... 00:C0:4E17:FF:FE  NS-Link 9.18 ON-LINE

192.108.11.01 00:C0:4E:40:FR:F0 NS-Link 9.23.1

m

B+ RT54 Spare COM Ports RTS-4P (DB9) 19216811.23  00:CO4EO7:FRFC SocketServer 818 ON-LINE
T T | B+ RTS2-Port RTS-2P (2E) 1921681152  00:COME:2:FRF5 SocketServer 918 ON-LINE (TCP)
this area. B Es9s28-XT ES9528-XT 19216811105 00:C0:4E:36:00:02 vid4 (b11.04) ON-LINE
Device Lisf Pane
™ i »
View & Edit the existing properties of the device First Floor 9 [1 [Ready
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Before Installing the Comtrol Drivers Management Console

4. Optionally, enter a friendly device name in the Device Name list box. The
default name is Device and the last three pairs of digits from the MAC address.

RTS_2E - 29:FF:F5 - Properties E@

Tools  Documentation ...

General | Software Settings ‘ Web Interface |

DeviceMaster RTS 2-Port (2E)

DEV/CE-MASTER'

Basic Information

Device Name : |RTS_2E - 23:FF:F5
MAC Address©  [DDCD:AE29FFFS
Serial Number : l—
Device Status : ’Wl
Detection Type : ’m
Network Settings
IFMode: [SwmiclP  ~]
IP Address: | 192 . 168 . 11 52
Subnet Mask : | 255 . 255 . 0 0

Default Gateway : | 192 . 168 . 1 254
Boctloader Timeout : [15
Apply Changes | Unda Changes ‘ w w

5. Optionally, enter the DeviceMaster serial number in the event you need to
contact Comtrol.

Note: The device status from the main screen displays in the Device Status list
box.

6. Select the appropriate Detection Type for this DeviceMaster.

e REMOTE means that IP communications are used instead of MAC
communications. This is generally an indication the DeviceMaster is not on
the local Ethernet segment

¢ LOCAL means that the MAC communications level is used and the
DeviceMaster must be on the local segment for MAC mode to be used. An
IP address is not required but Technical support recommends using an IP
address.

7. Select the appropriate IP Mode for your installation:

¢ Ifyou want to disable IP communications on the DeviceMaster, click
Disable IP.

e To use the DeviceMaster with DHCP, click DHCP IP, and make sure that
you provide the MAC address of the device to the network administrator.
Make sure that the administrator reserves the IP address, subnet mask
and gateway address of the DeviceMaster in the DHCP server.

e To program a static IP address, click Static IP and enter the appropriate
values for your site.

8. Leave the Bootloader Timeout set to the default 15.
9. Click Apply Changes and Close.
10. Go to the next subsection to check the SocketServer version.
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Before Installing the Comtrol Drivers Management Console

Check the SocketServer Version

Check the SocketServer version installed on the DeviceMaster against the latest
SocketServer version on the ftp site.

1.

If necessary, start PortVision DX: Start > Programs > Comtrol > PortVision DX >
PortVision DX.

Note: The SocketServer version displays for the DeviceMaster under the
Software Version column.

1PV PortVision DX =N =
File Manage View Tools Help
A0 —— y
-4 fn g » % " -~ Fi <§ h ‘) =
Scan  Refresh orties  Save J - Motes Help  About Exit
R -
- B v ES9528-KT [11/11]
-l v ES7506[0/1]
IPORTVIS MB - [l v ESTS10
( pX )] B v ESTS10-XT
- [ & EST528
B+ ES8508
" ESBS08F-M
MName : First Fioor - + ESB509-XT L
B v EsEsl0 3
B « ES8510-XT
@ v ESE510-XTE
1 + 10-Link Master #1
! * EtherMet/IP System
¢ LTi6 #2
Use menu or toobar to addnotesin - * Modbus Router System
e * Modbus/TCP
* PROS Console Port COM Ports [0 /1]
* RTS2-Port
* RTS4 Spare COM Ports
e * SHE Console Port COM Ports .
| [ Device Name [ Model [ 1P Address MAC Address | W Software Version | Status
B ESES28XT ES9528-XT 19216811105 00:CO4E36:00:02 14 (61104 ON-LINE
B RTS2-Port RTS-2P (2E) 1921681152  00:COM4E:29:FFF5 (SocketServer 918 ON-LINE (TCP)
Ell|my  LTIe#2 DM-LT16 1921681161  00:CO4EADFRFD | NS-Link 9.23.1 ON-LINE
B+ SHB Console Port COM Ports  SH-8P (DB9) 1921681114  00:CO:4E:LC:FRFD| NS-Link 9.18 ON-LINE
B+ RTS4 Spare COM Ports RTS-4P (DBY) 1921681123  00:CO4E07:FRFC | NS-Link 9.18 ON-LINE
B+ {8 PROE Console Port COM Ports ~ PRO-8P (DB9) 1921681120  00:CO4EAT:FRFE : ON-LINE
B+ Modbus Router System UP-4P (DB9) 1921681154  00:CO:4E07:43:84 Modbus Router 5.10 ON-LINE
B EtherNet/IP System UP-1P (5-30V) 1921681155  00:C0:4E:21:05:CD EtherNet/IP 410 ON-LINE
-||®v  ModbusTCP UP-IP(5V) 1921681153  00:CO4ELS:04:7A EtherNet/IP 410 ON-LINE
« 11 *
For Help, press F1 First Floor 9 [0 [Ready

2.

Check for the latest SocketServer version.

Note: Although these paths point to the DeviceMaster RTS subdirectory, the
software (applications, firmware, and drivers) and documentation
works on the DeviceMaster LT, DeviceMaster PRO and DeviceMaster
Serial Hub.

FTP subdirectory: ftp://ftp.comtrol.com/dev_mstr/rts/software/socketserver.

FTP directory /dev_mstr/rts/software/socketserver/ at ftp.comtrol.com

To view this FTP site in Windows Explorer, click Page, and then click Open FTP Site in Windows Explorer.

Up to higher level directory

800111 socketserver history.pdf

If necessary, download SocketServer, and then use the next subsection to
upload SocketServer. If you do not need to upload the latest version of
SocketServer, you are ready to install the device NS-Link device driver using
NS-Link Device Driver Installation on Page 17.
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Before Installing the Comtrol Drivers Management Console

Uploading SocketServer

The NS-Link device driver loads the current firmware but not until the
DeviceMaster has shown that an old version of the SocketServer (older than 8.00)
or any firmware other than NS-Link Updater is running. The driver does not
upload anything unless it first connects to the default application (SocketServer)

on the DeviceMaster.

Note: If you are familiar with the NS-Link driver, you may want to review

information for existing customers.

Optionally, you can upload the appropriate version of SocketServer after running
the NS-Link device driver Installation Setup Wizard.

Use the following procedure to upload the latest SocketServer version using

PortVision DX.

1. Start PortVision DX, click: Start > Programs > Comtrol > PortVision DX >

PortVision DX.

2. Right-click the DeviceMaster or DeviceMasters of which you want to upload
the latest version of SocketServer and then click Advanced > Upload Firmware.

1PV PortVision DX el e =
File Manage View Teols Help
v A~ y - - gy -
= & % 4 P 8 8 |- 0 A
Scan  Refresh | Properties S load  Upload Reboot Webpage Help  About Exit
B [Z= First Floor [8 / 8] -
5B v ES9528[9/9]
B v EST506
o i
IPORTVISM B v EsT510
( ) ) ----- B v EST510-XT
B v ES/528-3200:00 3/3]
B v ES8508
..... B ES8S08F-M
Name : First Floor P 1 I R R B v ES8509-XT =
B + ES8510
Rename
Move
. Delete
Use menu or toobar to add notesin =~ » Refresh
i Properties
Edit Notes
B pl
e Webpage
| | Device Nar Telnet / SSH Session [ = 1P Addr.. [ MAC Address | Software Version Status
LT 3 saaacassrcraacotcasncah Modbus Server 404 ON-LINE
By M 4 Esband B Modbus/TCP 5.07 ON-LINE
Sl|me R Configuration v Upload Firmware [, 3 SocketServer91l ON-LINE
Bv R i N NS-Link 911 ON-LINE
sv el Change Detection Type NS-Link 803
Iv 0 Help ... Assign P to Multiple Devices 5 EtherNet/IP 0.8.3
p g p
#v B B P Pigotsitie's Plokia
Bv E98 ES9528 V14 beted (b1103)  ON-LINE
‘ 0 »
Upload a new firmware into the selected device(s) FirstFloor 8 2 [Polling ...

3. Browse to the location where you downloaded SocketServer, highlight the file,

and click Open.

4. Click Yes to the Upload Firmware
popup.

5. Click Yes to the second Upload
Firmware popup.

You can click Refresh to verify that
the upload has been successfully
completed.

If the upload fails, use the PortVision
DX General tab on the Properties
screen to change the Bootloader
Timeout to 45 seconds and then repeat

Upload Firmware ... E3

IMPORTANT MOTES :

- This is a very sensitive process and shouldn't be interrupted at all.
- Any access to this application will be blocked during the process.
- It is highly recommended that you save the configuration of your
device(s) before uploading new firmware.
(Refer to PVDX help file for instructions)

Do you want to upload firmware to the selected Device(s) now?

No

Steps 2 through 5. If the upload fails again, use the TFTP procedure in the
DeviceMaster Installation and Configuration Guide.

16 - Uploading SocketServer
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NS-Link Device Driver Installation

This section discusses the following topics:
¢ Overview of the driver installation procedures

e Installation Setup Wizard on Page 17 for initial installation procedures

e  Checking the Device Driver Version on Page 22
e  Updating the Driver on Page 23

e Adding a DeviceMaster (Existing Installation) on Page 27

Overview

If there is an NS-Link device driver already installed on your system for the
DeviceMaster, use the following discussions:

e Euxisting Installations on Page 9

e  Updating the Driver on Page 23 if you want to update the existing driver.

e Adding a DeviceMaster (Existing Installation) on Page 27 to add more
DeviceMasters to the existing installation.

If you have performed the following procedures, you can skip to Installation Setup
Wizard to start NS-Link device driver installation.

You can use Before Installing the Comitrol Drivers Management Console on Page 9
for procedures for these steps.

1. Install the DeviceMaster.

2. Install PortVision DX.

3. Program the network information (IP address) using PortVision DX.
4

Upload the appropriate version of SocketServer firmware.

Installation Setup Wizard

You can use the following procedure to install the device driver and the Comirol
Drivers Management Console, which is used to configure the driver.

1. Locate the latest driver assembly (.exe) for your product and copy it to a
location that is available to the host.

e Download the latest device driver for the DeviceMaster.

e The Software and Documentation CD contains all of the files for
installation, configuration, and troubleshooting. The CD also provides
download links to the Comtrol ftp site to locate the latest files.

Note: Administrative privileges are required to install device drivers on
Windows operating systems newer than Windows Server 2003.

Do not connect RS-422/485 devices until the appropriate port interface
type has been configured in the device driver. The DeviceMaster

o default port setting is RS-232, except for the DeviceMaster Serial Hub.
aution
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NS-Link Device Driver Installation

2. Execute the NS-Link device driver assembly (DeviceMaster_Windows_x.xx.exe)
and click Next to start the installation.

DeviceMaster Driver Installation Setup ] ll

Welcome to the DeviceMaster
Driver Installation Setup
Wizard

The Setup Wizard will install DeviceMaster Driver Installation
on your computer, Click "Next" to continue or "Cancel” to
exit the Setup Wizard,

= Back. I Next>£| Cancel |

3. Optionally, enter a different location to install the driver files.

{5 DeviceMaster Driver Installation Setup ] =101l

Select Installation Folder

2
v

This is the Folder where DeviceMaster Driver Installation will be installed.

Tainstall in this Folder, click "Mext", To install to a different Folder, enter it below or click
"Browse",

Folder:

IC:'l,Program Files\Comtrol\DeviceMaster, Browse, .. |

Advanced Installer

< Back I Next>£ I Cancel

4. Click Install.

i'._% DeviceMaster Driver Installation Setup ] LI

Ready to Install

2
v

The Setup Wizard is ready to begin the DeviceMaster Driver Installation installation

Click "Install" ko begin the installation. IF you want to review or change any of your
installation settings, click "Back”. Click "Cancel” to exit the wizard,

Advanced Installer

< Back I Install [! Cancel
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NS-Link Device Driver Installation

5. Leave the Launch DeviceMaster Driver Installation box checked and click Finish.

DeviceMaster Driver Installation Setup 1 ll

Completing the DeviceMaster
Driver Installation Setup
Wizard

Click the "Finish" button to exit the Setup Wizard,

[V Launich DewviceMaster Driver Installation

= Back. I Finish IEI Cancel |

If you do not check this box, you can use the shortcut under the Start button at
Programs > Comtrol > DeviceMaster > DeviceMaster Driver Installation Wizard to
install the device driver.

6. Click Next to install the driver.
5I

Welcome to Comtrol Driver Installation
Wizard

This ‘Wizard will help wou Install or Update the
Comtrol driver on this computer, It will even allow
wou ko Uninstall such drivers from the computer if
wou wish to do so,

‘o may need to reskart wour computer in order to
complete the process.

Click Mext to continue or Cancel to exit this Wizard.

< Bach: | Mext = I Procesd Cancel
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NS-Link Device Driver Installation

7. Click Install and Next.

Comitrol Driver Installation wizard ) x|

Install, Update, or Uninstall driver

Select the operation you wish to perform:

@ Install

Select this option to install & new device and
update the associated driver(s),

€ Update
Select this option ko update the driver(s) far the
existing device(s).

" Remove Al

Select this option to remove the existing device(s)
and uninstall all the associated driver{s).

< Back | Mexk = I Brocesd Cancel

8. Select the DeviceMaster model that you want to install.

Comtrol Driver Installation wizard ! ll

Install a New Comtrol Device

You are about ko install 2 new Comtral Device Driver
on this computer,

As part of this process all previous installations of this
driver will be updated as well,

Please select the DeviceMaster models you want to
install and identify their quantities as well,

DeviceMaster Model | Quankit |:|
D DeviceMaster RTS 32 Port Mone
DeviceMaster PRO & Port 1

D DeviceMaster PRO 16 Pork Mone —I
O oevicetaster Serial Hub & Port Mone

A rm e b cbme Sl Lk 4 Pk Blmre LI

Click Mexk bo continue or Cancel to exit this ‘Wizard,

< Back | Mext >[\| Procesd | Cancel |
My

9. Enter the number of this DeviceMaster model that you want to install and
click Ok.

Device Quantity ? Iy x|

How many units of this DeviceMaster model you would like to install 7 |1 vl

[ I Cancel |

10. Repeat Steps 8 and and 9 for each DeviceMaster that you want to install and
click Next
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NS-Link Device Driver Installation

11. Click Proceed.
| Comtrol Driver Installationwizard x|

Summary

Driver Package :  DeviceMaster ;I
Selected Action : Install
Devicels) 1 1 DeviceMaster Unit(s)

IT IS HIGHLY RECOMMEMDED T CLOSE AMY ACTIVE
SERIAL PORT/APPLICATION BEFORE ¥OU PROCEED,
FAILURE T DO S0 WILL RESULT IM DATA LOSS |

=

Launch Comtral Drivers Management Console |

Click Proceed to continue or Cancel to exit this ‘Wizard,

< Back | Iexk = I ProceedJ Cancel

bt

You may see the following popup for each port.

i) Found New Edware IE‘
Comtral M3 Link Pol

12. Click the Launch Comtrol Drivers Management Console button.

13. Return to the
Installation wizard and
click Close to exit the
wizard.

14. Go to NS-Link Device
Driver Configuration
on Page 29 to start NS-
Link device driver
configuration.

Comtrol Driver Installation wizard | |

Summary

#+k IMPORTANT MESSAGE ¢ ;I
Flease wait a few moments For the background

installation of the Serial Ports to finish, You can then

use Comtrol Drivers Management Console to

configure the device driver you have just installed,

Finalizing ...
Finished,

-

The device driver
installation is not
complete until you have

| Launch Comtral Drivers Management Consale I

conbioa e VAC E—
address to the oy
DeviceMaster. Press Close to exit this Wizard,
15. After associating the
MAC address, go to < Back | [ext = | Proceed | Close k|

Configuring Device
Properties on Page 40
to set up device properties (device name and starting COM port number).

16. Go to Configuring COM Port Properties on Page 43 to configure any necessary
COM port characteristics.

After driver installation and configuration, connect the serial devices to the ports.
For information about the DeviceMaster connectors, refer to the DeviceMaster
Installation and Configuration User Guide (Page 7).
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NS-Link Device Driver Installation

Checking the Device Driver Version

Use the appropriate procedure for your operating system to check the Comtrol
device driver version using the Device Manager.

1.

2.

3.

Access the Device Manager using the appropriate method for your operating
system:

Windows 8 and Windows Server 2012:
Open Windows Metro Start.

Right-click any blank area and select All Apps.

a

b

c. Right-click Computer.

d. On the lower left corner, select Properties.

e. Click Device Manager.

Windows 7 and Windows Vista:

a. Click Start.

b. Right-click Computer.

c. Click Manage

d. Click Device Manager.

Windows Server 2008 R2:

a. Click Start.

b. Click Control Panel.

c. Change View by at the top to Large icons.

d. Click Device Manager.

Windows Server 2003 and Windows XP (Logged into a domain controller):
a. Right-click My Computer.

b. Click Manage

c. Click the Device Manager button.

Windows XP: Not logged into a domain controller:

a. Right-click My Computer.
b. Click Manage.
c. Click Device Manager.

Expand the Multi-port serial adapters entry, right-click the Comtrol device
that you want to configure, and then click Properties.

Click the Driver tab to view the NS-Link device driver version.

You can check this driver version against the latest driver for your product.

If necessary, you can update the device driver using the next subsection.
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NS-Link Device Driver Installation

Updating the Driver

Use the following procedure to update the DeviceMaster NS-Link device driver

after initial installation.

If you are unsure what driver version is running, see Checking the Device Driver

Version on Page 22.

Note: Make sure you review Existing Installations on Page 9 before updating the

device driver.

1. Locate the latest NS-Link device driver assembly (Page 7) and copy it to a
location that is available to the host.

2. Close any applications that are using serial ports before the NS-Link device

5.

driver installation.
Start the update by executing the .exe file.
Click Next to start the Installation Setup Wizard.

i'._% DeviceMaster Driver Installation Setup ) LI

Welcome to the DeviceMaster
Driver Installation Setup
Wizard

The Setup Wizard will install DeviceMaster Driver Installation
on your computer, Click "Next" to continue or "Cancel” to
exit the Setup Wizard,

= Back. I Next>£| Cancel |

Optionally, enter a different location to install the latest NS-Link device driver

files.

{5 DeviceMaster Driver Installation Setup ) =101l

Select Installation Folder

2
v

This is the Folder where DeviceMaster Driver Installation will be installed.

Tainstall in this Folder, click "Mext", To install to a different Folder, enter it below or click
"Browse",

Folder:
IC:'l,Program Files\Comtrol\DeviceMaster,

Browse. .. |

Advanced Installer

< Back I Next>£ I Cancel
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NS-Link Device Driver Installation

6. Click Install.

i'._% DeviceMaster Driver Installation Setup LI

Ready to Install

2
v

The Setup Wizard is ready to begin the DeviceMaster Driver Installation installation

Click "Install" ko begin the installation. IF you want to review or change any of your
installation settings, click "Back”. Click "Cancel” to exit the wizard,

Advanced Installer

< Back I Install [! Cancel |

7. Leave the Launch DeviceMaster Driver Installation box checked and click Finish.

eviceMaster Driver Installation Setup |

Completing the DeviceMaster
Driver Installation Setup
Wizard

Click the "Finish" button to exit the Setup Wizard,

[V Launich DewviceMaster Driver Installation

= Back. I Finish IEI Cancel |

If you do not check this box, you can use the shortcut under the Start button at:
Programs > Comtrol > DeviceMaster > DeviceMaster Driver Installation Wizard.
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NS-Link Device Driver Installation

8. Click Next to update the driver.
izard 1 |

Welcome to Comtrol Driver Installation
Wizard

This Wizard will help you Install or Update the
Comtrol driver on this computer, It will even allow
wou to Uninstall such drivers from the computer if
wou wish to do so,

‘fou may need ko restart your computer in order to
complete the process,

Click Mexk bo continue or Cancel to exit this ‘Wizard,

= Back. | Next; I Procesd Cancel

i

9. Click Update and Next.

mitrol Drives rd 1 |

Install, Update, or Uninstall driver
Select the operation you wish to perform:

7 Instal

Select this option to install a new device and
update the associated driveris),

& |pdate
Select this option to update the driver(s) for the

existing device(s),

7 Remove Al

Select this option to remaove the existing deviceds)
and uninstall all the associated driveris),

< Back I Mexk = | Procesd Cancel

i

10. Click Next to update the driver.

Update Existing Driver(s)

‘fou have chosen to replace your existing driver(s)
with the driver included in this package.

This update will impact all Comtrol hardware, from the
Following product Family, that reside on this PC and
use any version of this driver assembly,

Product Family: DeviceMaster

Click Mexk bo continue or Cancel to exit this ‘Wizard,

< Back | ML = Proceed Cancel
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NS-Link Device Driver Installation

11. Click Proceed.

4 Comtrol Driver Installation wizard ==
Summary
Driver Package :  DeviceMaster -

Selected Action :  Update
Device(s) : All DeviceMaster Units

IT IS HIGHLY RECOMMENDED TO CLOSE ANY ACTIVE
SERIAL PORT/APPLICATION BEFORE YOU PROCEED.
FAILURE TO DO SO WILL RESULT IN DATA LOSS !

Launch Comtral Drivers Management Console

Click Proceed to continue or Cancel to exit this Wizard.

< Back I Mexk = | Prooeedl\J Cancel |
L

12. Click the Launch Comtrol Drivers Management Console button to configure the
ports or device properties.

13. Return to the Installation wizard and click Close.

Comtrol Driver Installation wizard __ I ll

Summary

#+k IMPORTANT MESSAGE ¢ ;I
Flease wait a few moments for the background

installation of the Serial Ports to finish, You can then

use Comtrol Drivers Management Console to

configure the device driver you have just installed,

Finalizing ...
Finished,

-

Launch Comtrol Drivers Management Console le

|

Press Close to exit this Wizard,

= Back | Iexk = | Procesd I Close |

14. If necessary, go to Configuring COM Port Properties on Page 43 to configure
the NS-Link COM port properties
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NS-Link Device Driver Installation

Adding a DeviceMaster (Existing Installation)

Caution

Use the following procedure to add aDeviceMaster to an existing DeviceMaster

installation.
1. Close any applications that are using serial ports before the device driver
installation.
2. Connect the DeviceMaster to your network and use PortVision DX to program
the IP address.
If you need hardware installation procedures, see Downloading the Latest
Software and User Guides on Page 7).
Do not connect RS-422/485 devices until the appropriate port interface
type has been configured in the device driver. The default port setting
is RS-232.
3. From the Start button, click:
4. Click Next to start the Comtrol Driver Installation Wizard.
| comtrolbrver nstalstonwzard zl
Welcome to Comtrol Driver Installation
Wizard
This Wizard will help you Install or Update the
Comtrol driver on this computer, It will even allow
wou to Uninstall such drivers from the computer if
wou wish to do so,
‘fou may need ko restart your computer in order to
complete the process,
Click Mexk bo continue or Cancel to exit this ‘Wizard,
= Back. | Mexk = I Procesd Cancel
5. Click Install and Next.
| comtrol briver Installation wizard x
Install, Update, or Uninstall driver
Select the operation you wish to perform:
' Install
Select this option to install & new device and
update the associated driver(s).
' Update
Select this option ko update the driver(s) for the
existing device(s).
© Remove Al
Select this option to remove the existing device(s)
and uninstall all the associated driver(s).
< Back | Mexk = I Procesd | Cancel |
6. Click Next and follow the Installation Wizard. Refer to Step 8 on Page 20, for

the remainder of the installation steps if needed.
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NS-Link Device Driver Configuration

If you programmed an IP address into the DeviceMaster for your network using
PortVision DX before installing the NS-Link device driver; first associate the MAC
address to the DeviceMaster and then configure the driver with the IP address
that you programming into the DeviceMaster using PortVision DX.

This section discusses the following topics:

e NS-Link Device Driver Configuration Considerations

e Using the Comtrol Drivers Management Console on Page 31
e Associating the MAC Address on Page 36

e Using IP Mode and Enabling SSL on Page 38

e Configuring Device Properties on Page 40

e Configuring COM Port Properties on Page 43

e Network Configuration in Comitrol Drivers Management Console on Page 49
- Disabling IP Mode on Page 49
- Changing a Static IP Address on Page 50
- Setting Up DHCP on Page 51

e Configuring DeviceMaster Ports as Sockets on Page 53

e FEnabling Secure Data Mode on Page 54

NS-Link Device Driver Configuration Considerations

The following subsections discuss the NS-Link device driver features and topics
that you may want to review before driver configuration.

IP or MAC This is an overview of IP and MAC addressing issues that may affect how you
Addressing Issues configure the DeviceMaster with a brief discussion of advantages of each method.

Note: The default IP address for the DeviceMaster is 192.168.250.250.
The IP addressing scheme (IP mode) has the following advantages:
¢ Uses an IEEE industry standard protocol.

e Allows you to configure systems to use ports on the DeviceMaster that are
outside of the host system’s local Ethernet segment.

Note: This IP address must be a unique reserved IP address. Do not use an
address from a dynamic address pool. If necessary, see the system
administrator for an IP address.

The MAC addressing method (MAC mode) has the following advantages:

¢ Simplifies implementation and ongoing support by eliminating the address
administration issues inherent in network protocols. MAC addresses are
predefined by DeviceMaster and there is no potential for an address conflict at
setup.

e Tt isisolated from foreign LAN segments minimizing potential security issues.
¢ Maximizes throughput of serial data.
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NS-Link Device Driver Configuration

NS-Link Device
Driver Features

Using the Port
Sharing Feature

During initial installation and configuration of the NS-Link device driver, Comtrol
recommends that you associate the MAC address to the DeviceMaster. If you do
not do so, you will not be able to use the following device driver features:

e Access the Advanced tab to review PC network or device network interface
statistics

e Program or change an IP address using through the Network Settings button
¢ Reboot the DeviceMaster from the Com¢rol Drivers Management Console

After associating the MAC address, you can then program the DeviceMaster for IP
or DHCP usage.

You can refer to IP or MAC Addressing Issues on Page 29 for information about
MAC addressing and IP addressing issues.

DeviceMaster ports can be shared by installing the NS-Link device driver on
multiple systems or through socket mode, or combination of both. To do so, install
the NS-Link driver on each system that you want to permit access to the serial
ports. You can share the same port with multiple systems (only one system can
have an open connection to a port at any given time) or you can set up multiple
systems to share specific ports on the device driver..

DeviceMaster
Port 1 Port 2 Port 3 Port 4

COM 5 COM 6 COM 5 COM 6
Configured for System A Configured for System B

Ethernet Hub
System A

Multiple systems can use the same COM port names.
Example:
To configure two ports for System A and two ports for System B,
you could configure the drivers like this:

1. When installing the device driver on System A, click “Not Configured” for the
COM port names for Ports 3 and 4.

2. When installing the device driver on System B, click “Not Configured” for the
OM port names for Ports 1 and 2.

System B

Use port sharing to configure redundant PCs or fail-over protection.

Port System A System B
1 |COM5 Not Configured

2 |COM6 Not Configured

3 |Not Configured |COM5

4 |Not Configured |COM6

Note: Most applications do not release ports, so you may not be able to use port
sharing across multiple systems with the same port. Also, if using port
sharing, make sure that two computers do not try to access the same port at
the same time. Only one computer can control a given port at a given time.
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NS-Link Device Driver Configuration

Using the Comtrol Drivers Management Console

Accessing the
Comtrol Drivers
Management
Console

Displaying All
Installed Devices

This subsection discusses basic Comtrol Drivers Management Console operations,
such as:

e Accessing the Comtrol Drivers Management Console
e Displaying All Installed Devices on Page 31

e Expanding the View on Page 32

e How to Configure Device Properties on Page 32

e Customizing the Device Name on Page 33

e Customizing the COM Port Name on Page 33

e  How to Configure COM Port Properties on Page 34

e  How to Save Changes on Page 35

See Associating the MAC Address on Page 36 to start DeviceMaster configuration
procedures.

Accessing the Comtrol Drivers Management Console can be done using one of the
following methods:

e Windows Control Panel; go to your Control Panel and click on the Comtrol
Drivers Management Console.

e Shortcut; located under Start > Program Files > Comtrol > DeviceMaster >
Comtrol Drivers Management Console.

The Comtrol Drivers Management Console opens and displays all products for
which a device driver was installed.

€ Comtrol Drivers Management Console @

ol DeviceMaster

- RocketPort Infinity/Express In order to view / modify the configuration of any Comtrol Device or Serial Port (COM Port), you need
to first select it from the tree on the left.

-~ RocketPort/RocketModem

Comtrel Drivers Management Console version 2,00
Copyright (C) 2011-2012 Comtrol Corporation.

Save Configuration | | Load Configuration Apply
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Expanding the View

How to Configure
Device Properties

To view a device or devices under a product family, click the + in the Tree View

pane to open the selected family.

e Comtrol Drivers Management Console

e

(=) %888 DeviceMaster LT, 16 Port
7 Portoi (comit)
Port 02 (COM17)
Port 03 (COM18)
Port 04 (COM19)
Port 05 (COM21)
Port 06 (COM24)
Port 07 (COM25)
Port 08 (COM25)
Port 09 (COM35)
Port 10 (COM35)
Port 11 (COM38)
Port 12 (COM38)
Port 13 (COM40)
Port 14 (COM41)
Port 15 (COM42)
we IF Port 16 (COM43)
KB DeviceMaster PRO, 8 Port
--AgEEh DeviceMaster RTS, 4 Port

dddeleeleldlelatetele

In order to view / modify the configuration of any Comtral Device or Serial Port (COM Port), you need
to first select it from the tree on the left.

This overview discusses changing device properties for a product. Highlight the
device name of the product that you want to configure in the Tree View pane. Make
any necessary changes.

e Click Apply to save the changes, which saves the changes and leaves the
Comtrol Drivers Management Console open.

e (Click Ok to save the changes and close the Comtrol Drivers Management
Console.

¢ (Click Cancel to close the Comtrol Drivers Management Console without saving
the changes.

If you click a port or device name without saving the changes, the Comtrol Drivers
Management Console will prompt you to Apply, Ignore, or Cancel the changes.

For more information, see Configuring Device Properties on Page 40.

G Comtrol Drivers Management Consaole

- DewiceMaster
& DeviceMaster LT, 16 Port
E| & -] DeviceMaster PRO, 8 Port
[ 5 Port 01 (COM103)
¥ Port 02 (COM108)
- 4 Port03 (com12)
& Portos (com110)
- Port0s (CoM102)
 portos (com104)
- 5 Port07 (COM20)
¢ e B portos (com109)
[+]--"EEE DeviceMaster RTS, 4Port
s DeviceMaster Serial Hub, 8 Port
- RocketPort Infinity/Express
RocketPort/RocketModem

General | T

Network Connection Mode
() MAC Mode 00 CO 4E 17 FF FB -

= Metwork Settings
OPMade 1523681120 [ etworksetings |
Enable 55L Mode e

[ server Certificate
Client Certificate: -

Device Settings
Device Name:  DeviceMaster PRO, 8 Port

UserFriendly Device Name:  DeviceMaster PRO, 8 Port

Keep Alive Timeout (seconds): 120 (Default: 120)
TCP Timeout Multiplier: 1 (Default: 1)
Scan Rate (ms): 10 ¥ (Default: 10)
Mumber of Devices to Load at Once: 20 (Default: 20)

Do NOT Load Firmware to Device D

Verbose Eventlog [] (Troubleshooting Only) Defaults

Comtrol Drivers Management Console version 2.11
Copyright {C) 2011-2013 Comtrol Corporation.

Save Cunﬁguraﬁoﬂ] [Luad Conﬁguraton] i CK ] [ Cancel ] Apply
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Customizing the
Device Name

Customizing the
COM Port Name

Change the default Device Name on the Device General tab by changing the name
in the User-Friendly Device Name field and saving the change.

e Comtrol Drivers Management Conscle

R

=R ___JPRO - Rocketlink Console Ports|
Y Port 01 (CoM103)

F Port 06 (cOM104)
A Port 07 (coman)

(SRS DeviceMaster General T
N DeviceMaster LT, 16 Port
& DeviceMaster RTS, 4Port Network Connection Mode
& DeviceMaster Serial Hub, 8 Port 7 MAC Mode 00 CO 4E 17FF FB -

Device Settings

Metwork Settings

@ 1P Mode 192.168.11.20
Fort 03 (COM12)
5 port 04 (coM110) [T Server Certificate
7 portos (coM102) Client Certificate: m

i 5 portos (coM103) Device Name:  DeviceMaster PRO, 8 Port

RocketPort Infinity/Express User-Friendly Device Name:  PRO - Rocketlinx Console Ports

RocketPort/RocketModem -
Keep Alive Tmeout (seconds): 120 (Default: 120)
TCP Timeout Multiplier: 1 (Default: 1)
Scan Rate (ms): 10 * (Default: 10)
Number of Devices to Load at Once: 20 (Defaut: 20)
Do MOT Load Firmware to Device D
Verbose EventLog [] (Troubleshooting Only) Defaults

Comtrol Drivers Management Console version 2,11
Copyright {C) 2011-2013 Comtrol Corporation.

ISave Configuration ] [Load Configuration ] l

0K ][ Cancel ] Apply

Help

Change the default Port Name on the Port Settings General tab by changing the
name in the User-Friendly Port Name field and saving the change.

e Comtrol Drivers Management Conscle

=R

Port 04 (COM110)

DeviceMaster General
N DeviceMaster LT, 16 Port
S DeviceMaster RTS, 4 Port Port Settings

[T Map 2 Stop Bits to 1

232 -

& DeviceMaster Serial Hub, & Port RS Mode:
|- kg PRO - Rocketlink Console Ports T
(y E58510 (COM103) Override and Lock Baud Rate to: ~ MNone -
rr—\."? Transmit Data Timeout on Port Close; 0 ~ (seconds)
5 Port 03 (COM12)

[ Wit on Physical Transmission before Completing Write
[ Emulate Modem Hardware RING Signal

[] Allows Parity Conflict (DeviceMaster 1 Port only)

[T Block Plug-H-Play Search for Attached Serial Device

i’; Port 05 (COM102)
7 portos (com104)
o porto7 (com20)
 port0s (com109)
RocketPort Infinity/Express
RocketPort/RocketModem

Defaults

Clone

[] Apply These Settings to All Ports

Port Name

User-Friendly Port Mame: ~ ES8508

COM Name: |COM10& ~J

[T Renumber All Subsequent Ports Relative to This Port

Comtrol Drivers Management Console version 2,11
Copyright {C) 2011-2013 Comtrol Corporation.

[Sa\te Conﬁgurahon] [Load Conﬁgurauonl [ OK ] [ Cancel Apply Help
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How to Configure
COM Port
Properties

To change a port’s properties for a product, highlight the port of the product that
you want to configure in the Tree View pane. Make any necessary changes:

¢ Click Apply to save the changes, which saves the changes and leaves the
Comtrol Drivers Management Console open.

¢ (Click Ok to save the changes and close the Comtrol Drivers Management
Console.

¢ (Click Cancel to undo the changes and close the Comtrol Drivers Management
Console.

If you click another port or device name without saving the changes, the Comtrol
Drivers Management Console will prompt you to Apply, Ignore, or Cancel the

changes.

For more information, see Configuring COM Port Properties on Page 43.

After saving the port changes, if desired, you can click Apply These Settings to All
Ports to populate the remaining ports with these NS-Link COM properties.

e Comtrol Drivers Management Console

DeviceMaster

@8 DeviceMaster LT, 16 Port

8 DeviceMaster RTS, 4 Port
A& DeviceMaster Serial Hub, 8 Port

‘. AE@ PRO - Rocketlin Console Ports

bee B ES8510 (COM103)
7 Esss0a (com108)
A Portos(com1z)
7 ESB510-XTE (COM110)
-
7 Es7510 (CoM104)
¥ Port 07 (COM20)
7 Port0s (coM109)

-  RocketPort Infinity fExpress
- RocketPort/RocketModem

General |

Port Settings

RS Mode: 232 - 275 Toadle
Override and Lock Baud Rate to: ~ Mone - Options
Transmit Data Timeout on Port Close: 0 v (seconds)

[F]Map 2 Stop Bits to 1

[] wait on Physical Transmission before Completing Write
[ Emulate Modem Hardware RING Signal

[ allow Parity Conflict (DeviceMaster 1 Port only)

[ Block Plug-N-Flay Search for Attached Serial Device

Defaults

Clone

[] Apply These Settings to All Ports

Port Name

User-Friendly Port Name: ~ ES8509-XT

COM Name: _CDM 102 —

[]Renumber All Subsequent Ports Relative to This Port

Comtrol Drivers Management Console version 2.11
Copyright (C) 2011-2013 Comtrol Corporation.

Save Conﬁguratun] [Load Cunﬁgurah’un] [ OK ] [ Cancel Apply
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How to Save
Changes

The Comtrol Drivers Management Console indicates that changes have been made

on this screen with a red frame that identifies which device’s General tab you are
editing.

Clicking the Apply button saves the changes on the tab and leaves the Comtrol
Drivers Management Console open for further configuration.

Clicking the Ok button saves the changes on that tab and closes the Comtrol
Drivers Management Console.

Clicking the Cancel button cancels the changes on that tab and closes the
Comtrol Drivers Management Console.

e Comtrol Drivers Management Conscle

+ DewviceMaster
E DeviceMaster Serial Hub, 8 Port
T i skl
This frame indicates that changes 1
have been made but not applied. 12)
Lo aiuman wdM107)

m

General | Advanced

Network Connection Mode

(7) MAC Mode 00 CO 4E 1ICFFFD
@ P Mode 192.188.11.14
Device Settings
Device Name:

DeviceMaster Serial Hub, & Port

- Metwork Settings
Reboot Device

(y Port 02 (COM4) UserFriendly Device Name: ~ DeviceMaster Serial Hub, 8 Port
& Porto3 (coms) L4
- ;j Part 04 (COMS) Keep Alive Timeout (seconds): 120 (Default: 120)
w5 ESB509-KT (COM102)
.. ;j ES7510 (COM104) TCP Timeout Multiplier: 1 (Default: 1)
S porto7 (coms)
Scan Rate (ms): 10 :
4 Port0a (com10) e bl (BT 1T
-\ DeviceMaster RTS, 2Port, 22 Number of Devices to Load at Once: 20 (Default: 20)
i B portol(comazs)
(y Port 02 (COM26) Do NOT Load Firmware to Device [
RocketPort Infinity/Express Verbose EventLog || (Troubleshooting Only)
Defaults
i S Porto1(comin =
Comtrol Drivers Management Console version 1.07
Copyright {(C) 2011-2012 Comtrol Corporation. Save Configuration ] [ Load Configuration ] [ OK i [ Cancel ] [ Apply ] [ Help ]
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Associating the MAC Address

Same Network
Segment

The first step to configuring the NS-Link device driver is to associate the MAC
address of the DeviceMaster to the device driver.

You can use the method that is appropriate to your installation:
e Same Network Segment (below)
e Different Physical Segment on Page 37

Although you can and should associate a MAC address on a different physical
segment, the DeviceMaster must be connected to the local network segment or
directly to a NIC on the host system for the NS-Link driver to operate in MAC
Mode.

The DeviceMaster must be connected to the local network segment or directly to a
NIC on the host system to operate in MAC mode and in order for PortVision DX to
detect the MAC address, otherwise you must enter the MAC address manually.

Use the following procedure to associate a MAC address to a DeviceMaster.

1. Ifnecessary, access the Comtrol Drivers Management Console, click Start >
Control Panel > Comtrol Drivers Management Console.

2. Highlight the Device Name of the DeviceMaster that you want to configure.

e Comtrol Drivers Management Console @

[ DeviceMaster = General | Advanced ‘
& DeviceMaster Serial Hub, 8 Port
e F‘y‘ Port 01 (COM11) Network Connection Mode
- 2 Port02(COM12) (@ MAC Mode

ES7510-XT (COM107) 3 TS

# ES7528 (COM101) OPMode 002 177F FD
E57506 (COM100) Enable 55L M 00 €O 4E 17 FF FF -

i Es9528 (COM105) F orver DO 2 £ £ Reboot Device
ES8510-XTE {COM106)

7 Port 08 (cam18) Client Certificate:

—I--%&58 PRO - Console Ports - 3
¥ Esss10 (coM103) Tt )

Part 02 (COM4) Device Name:  DeviceMaster PRO, 8 Port
Port 03 (COMS) L4 User-Friendly Device Name:  PRO - Console Ports
Port 04 (COME)

¥ ES8509-XT (COM102) Keep Alive Tmeout (seconds): 120 (Default: 120)
ES7510 (COM104)

& Port 07 (COM3) TCP Timeout Multiplier: 1 (Default: 1)
Port 08 (COM10)

DeviceMaster RTS, 2 Port, 2E a1 ~ QU=
o ry Port 01 (COM25) Mumber of Devices to Load at Once: 20 (Default: 20)
7 Port 02 (comas)
(e RocketPort Infinity/Express Do NOT Load Firmware to Device D
- BB EXPRESS 8P Verbose EventLog [| (Troubleshooting Only)
b S Port01(comizy &

Comtrol Drivers Management Console version 2.00
Copyright {C) 2011-2012 Comtrol Corporation.

[Save Cunﬁguraﬁon] [LoadConﬁgurahun] [ OK ] [ Cancel ] Apply

3. Select the MAC address from the drop-down list or enter the address from the
MAC address label on the DeviceMaster.

If the appropriate MAC address is not displayed in the drop-down list, then it
can be one of the following reasons:

¢ The DeviceMaster is not on the same network segment

¢ The DeviceMaster not powered on or connected to the network

¢ The DeviceMaster wrong model was selected during the driver installation
¢ Device failure

Note: Ifyou enter the MAC address, make sure that you use the correct format:
00 CO 4E xx xx xx. A space must separate each pair of digits. The MAC
address is located on a label on the DeviceMaster.

36 - Associating the MAC Address
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If you programmed the IP address using PortVision DX, the IP address
displays in the IP Mode text box.

4. Click Apply to program the driver with the MAC address of the DeviceMaster.

If you do not Apply the changes before leaving this screen, you will be
prompted to Apply, Ignore, or Cancel the changes.

5. Optionally, you can click the Advanced tab and verify that the Device Status
message indicates that the DeviceMaster is active and Ok.

6. You may need to perform some of the following tasks to complete the driver
configuration process.

¢ Configure the DeviceMaster for IP Mode, see Using IP Mode and Enabling
SSL on Page 38

¢ Configure device properties, see Configuring Device Properties on Page 40.

¢ Configure COM port properties, see Configuring COM Port Properties on
Page 43.

¢ Configure any of the DeviceMaster ports as sockets, see Configuring
DeviceMaster Ports as Sockets on Page 53.

Different Physical

Use the following procedure to associate a MAC address to a DeviceMaster that is
Segment

not on the same physical network segment or not connected directly to the NIC.
1. Ifnecessary, start the Comtrol Drivers Management Console.

2. Highlight the Device Name of the DeviceMaster that you want to configure.
3. Enter the MAC address in the MAC Mode text box.

e Comtrol Drivers Management Console

B DeviceMaster A
14888 DeviceMaster Serial Hub, 8 Port (DeviczMas| |
~ 5 porto1(comiy)
Port 02 (COM12)
E57510-XT (COM107)
E57528 (COM101)

- 5 Es7506 (COM100)
- S E59528 (COM105)
- 5 E58510-XTE (COM106)
~ 5 Portos (CoM18)

General | Advanced

Network Connection Mode
00 C04E ICFFFD -

@) MAC Mode

Metwork Settings
Reboot Device

IP Mode
Enable 551 Mode

m

Server Certificate
Client Certificate:

<

.. B FYPRFSS AP (RocketPort FXPRESS. Orta. NF T
il +

--%&E PRO - Console Ports (DeviceMaster FRO, 8
- 3 Es8510 (CcoM103)

~ S Portoz (coMq)

~ 5 Porto3(coms)

- 5 Porto4(coMs)

i ES8509-XT (COM102)

E57510 (COM104)

Port 07 (COM3)

- 5 Port0s (CoM10)

DeviceMaster RTS, 2 Part, 2E (DeviceMaste
Port 01 (COM25)

7 portoz(comzs)

RocketPort Infinity/Express

Device Settings
Device Mame:

User-Friendly Device Name:

Keep Alive Timeout (seconds):

TCP Timeout Multiplier:

Scan Rate (ms):

Number of Devices to Load at Once:

Do NOT Load Firmware to Device
Werbose Event Log

DeviceMaster Serial Hub, 8 Port
DeviceMaster Serial Hub, 8 Port
120 (Default: 120)
1 (Default: 1)
10 * (Default: 10)
20 (Default: 20)

b

[7] (Troubleshooting Only)

Defaults

Copyright (C) 2011-2012 Comrol Corporation.

Comtrol Drivers Management Console version 2.00

|save Configuration | [ Load Configuration | [

ok | [ cancel | Apply

Note: When you enter the MAC address, make sure that you use the correct
format: 00 CO 4E xx xx xx. A space must separate each pair of digits.

A MAC address is located on a label on the DeviceMaster or use
PortVision DX to scan the network, which will display the MAC

address.

4. Click Apply to program the driver with the MAC address of the DeviceMaster

or Ok to save the change and close the Comtrol Drivers Management Console.
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If you do not Apply the changes, you will be prompted to Apply, Ignore, or
Cancel the changes.

5. You may need to perform some of the following tasks to complete the driver
configuration process.

¢ You can now configure the DeviceMaster to operate in IP Mode using the
next subsection.

¢ Configure device properties, see Configuring Device Properties on Page 40.

¢ Configure COM port properties, see Configuring COM Port Properties on
Page 43.

¢ Configure any of the DeviceMaster ports as sockets, see Configuring
DeviceMaster Ports as Sockets on Page 53.

Using IP Mode and Enabling SSL

After associating the DeviceMaster with the MAC address you can set the
DeviceMaster to run in IP Mode.

1. First associate a MAC address (Page 36) to the DeviceMaster.
2. Highlight the DeviceMaster.

3. Ifthe DeviceMaster is on the same network segment, the driver populates the
IP Mode text box with the DeviceMaster IP address.

If the DeviceMaster is not on the same network segment, enter the IP address
of the DeviceMaster in the IP Mode text box.

4. Click the IP Mode radio button.

e Comtrol Drivers Management Console

2 sl

[y DeviceMaster - General ‘ Advanced
- fE58] DeviceMaster Serial Hub, 8 Part (DeviceMas| |
b F\y’ Port 01 (COM11) Network Connection Mode
~F Portoz (comz) ()MACMode 00 CO % ICFFFD -
A EST510-4T (COM107) 5
- & ES7528 (COM101) @ 1P Mode 192.168.11.14
- & E57506 (COM100) = Enable S5L Mode 3
e Fx,i E59528 (COM105) b = B
% ES8510-XTE (COM106) :
/;Q Port 08 (COM18) Client Certificate: -
~XeE@ PRO - Console Ports (DeviceMaster PRO, 81
- J ESB510 (COM103) BerE=E=iE .
e fy Part 02 (COM4) Device Name:  DeviceMaster Serial Hub, 8 Port
F\Zi Port 03 (COMS) User-Friendly Device Name:  DeviceMaster Serial Hub, 8 Port
7 port 04 (coms)
- Jf ESBS08T (COM102) keep Alive Timeout (seconds): 120 (Default: 120)
oo o ES7S10 (COM104)
F\;ﬂ Port 07 (COM3) TCP Timeout Multiplier: 1 (Default: 1)
Port 08 (COM10)
=3 N DiuceMaster RTS, 2 Port, 2E (DeviceMaste SonaEine iy 10 M
- 9 Porto1 (comas) Number of Devices to Load at Once: 20 (Default: 20)
o o Portoz (comzs)
B RocketPort Infinity/Express Do NOT Load Firmware to Device [
1 BB _FXPRFSS &P MacketPort FXPRFSS. Octa. D ™ Verbose Eventlog [ (Troubleshooting Only)
4 ] | b

Comtrol Drivers Management Consale version 2,00
Copyright (C) 2011-2012 Comtrol Corporation.

lsava Configuration ] [Load Canfiguration ] [ QK.

J[ Cancel ][ ADDI%J[ Help ]

5. Optionally, click Enable SSL Mode or go to Step 8.

The DeviceMaster must be configured using IP Mode before you can Enable
SSL Mode. If SSL Mode is enabled, TCP connections that carry data to/from
the serial ports are encrypted using SSL or TLS security protocols. This
includes the following:

e TCP connections to the per-serial-port TCP ports (default is 8000, 8001,
8002, ...) are encrypted using SSL/TLS.
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¢ TCP connections to TCP port 4606 on which the DeviceMaster implements
the Comtrol proprietary serial driver protocol are encrypted using SSL/
TLS.

e Since SSL/TLS can not be used for either UDP data streams or for the
Comtrol proprietary MAC mode Ethernet driver protocol, both UDP and
MAC mode serial data transport features are disabled.

In addition to encrypting the data streams, it is possible to configure the
DeviceMaster so that only authorized client applications can connect using

SSL/TLS.

For this option to function, you must also_Enable Secure Data Mode in the NS-
Link web page.

6. Ifyou are using a server certificate, click the Server Certificate check box and
enter the name in the Server Certificate text box.

This is the RSA identity certificate that the DeviceMaster uses during SSL/
TLS handshaking to identify itself. It is used most frequently by SSL server
code in the DeviceMaster when clients open connections to the DeviceMaster's
secure web server or other secure TCP ports.

If a DeviceMaster serial port configuration is set up to open (as a client) a TCP
connection to another server device, the DeviceMaster also uses this certificate
to identify itself as an SSL client, if requested by the server.

7. Ifyou are using a client certificate, click the drop list and browse to the
appropriate client certificate file.

When configured with a CA certificate, the DeviceMaster requires all SSL/TLS
clients to present an RSA identity certificate that has been signed by the

configured CA certificate. As shipped, the DeviceMaster is not configured with
a CA certificate and all SSL/TLS clients are allowed.

If desired, controlled access to SSL/TLS protected features can be configured
by uploading a client authentication certificate to the DeviceMaster.

When a CA certificate is uploaded, the DeviceMaster only allows SSL/TLS
connections from client applications that provide to the DeviceMaster an
identity certificate that has been signed by the CA certificate that was
uploaded to the DeviceMaster.

This uploaded CA certificate that is used to validate a client's identity is
sometimes referred to as a trusted root certificate, a trusted authority
certificate, or a trusted CA certificate. This CA certificate might be that of a
trusted commercial certificate authority or it may be a privately generated
certificate that an organization creates internally to provide a mechanism to
control access to resources that are protected by the SSL/TLS protocols.

To control access to the DeviceMaster's SSL/TLS protected resources you
should create your own custom CA certificate and then configure authorized
client applications with identity certificates signed by the custom CA
certificate.

8. Click Apply or Ok to save the change and close the Comirol Drivers
Management Console

9. You may need to perform some of the following tasks to complete the
configuration process.

¢ Configure device properties, see Configuring Device Properties on Page 40.

¢ Configure COM port properties, see Configuring COM Port Properties on
Page 43.

¢ Configure any of the DeviceMaster ports as sockets, see Configuring
DeviceMaster Ports as Sockets on Page 53.

e Enable Secure Data Mode in the NS-Link web page, see Enabling Secure
Data Mode on Page 54.
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Configuring Device Properties

Use the following procedure to change device settings on a DeviceMaster.

1. Open Comtrol Drivers Management Console (Accessing the Comtrol Drivers
Management Console on Page 31).

2. Highlight the DeviceMaster device name that you want to configure.

e Comtrol Drivers Management Console @
[ DeviceMaster - General ‘ Advanced
=) &8 DeviceMaster Serial Hub, 8 Port (DeviceMas| |
e F\yf Port 01 {COM11) Network Connection Mode
7 Port02 (COM12) (7)MACMode DO CO % ICFFFD -
e ES7S10XT (COM107) : Network Settings
”__\y( ES7528 (COM101) @) IP Mode 192.168.11.14
e ES7506 (COM100) -
K c 7] Enable S5 Mode ——
it "'y ES9528 (COM103) [ server Certificate
e # ES8510-XTE (COM108)
" ry Port 08 (COM18) Client Certificate: -
- %58 PRO - Console Ports (DeviceMaster PRO, 81 B ==
- & ES8510 (COM103) s st Device Name:  DeviceMaster Serial Hub, 8 Port
U port 02 (com) B : eviceMaster Serial Hub, 8 Por
i ry Port 03 (COMS) User-Friendly Device Name:  DeviceMaster Serial Hub, 8 Port
7 Port o4 (coms)
— F\,i ES8509-XT (COM102) Keep Alive Timeout (seconds): 120 (Default: 120)
7 Es7s10 (COM104)
h__\,f Port 07 {COMS) TCP Timeout Multiplier: 1 (Default: 1)
7 port 03 (Com10)
;10 = E
|| %888 DeviceMaster RTS, 2 Port, 2E (DeviceMaste Scppaias) e
~e A Port 01(COM25) Number of Devices to Load at Once: 20 (Default: 20)
w I Port 02 (CoM26) : ;
S~ RocketPort Infinity/Expi Do NOT Load Firmware to Device [
=1 BB FYPRFSS AP fRocketPort FYPRFSS. Octa. DF Verbose EventLog [| (Troubleshooting Only) Defaults
4 [ | »
Comtrol Drivers Management Consale version 2,00
Copyright (C) 2011-2012 Comtrol Corporation. [save configuration | [Load Configuration | [ ok | [ cancel | Apply

3. If desired, change the User-Friendly Device Name.

4. Optionally, set a different Keep Alive Timeout (Page 41) period. You can set the
amount of time in seconds that this DeviceMaster waits until it closes this
connection and frees all the ports associated with it.

Note: This value may be set to less than 5 seconds, however the DeviceMaster
may not operate at any value less than 5. A recommended value to begin
experimentation with is 10.

5. Optionally, set the TCP Timeout Multiplier (Page 42) value.

Note: This value should not be modified unless the network connection to the
DeviceMaster is very slow, such as, if a satellite uplink connection is
involved. It is recommended that a value over 3 never be used.

Optionally, click a different Scan Rate (ms) (Page 42).
Optionally, change the Number of Devices to Load at Once (Page 42).
If necessary, click Do NOT Attempt to Load Firmware in Device (Page 42).

Optionally, click Verbose Event Log if you want to log additional DeviceMaster
information into the event log.

© ® 3o

10. After making your changes, click Apply if you have additional configuration
procedures or click Ok if you have completed configuring your Comtrol devices.

Note: If you do not Apply the changes, you will be prompted to Apply, Ignore, or
Cancel the changes.

The following table provides detailed information about Device General tab options
for the DeviceMaster.
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Device General Tab

Description

Device Name

This is the default name assigned by the driver and it cannot be
changed. You can use the User-Friendly Device Name field to provide
custom device names for your installation.

User-Friendly Device Name

Use this field to enter a more descriptive name. The name that you
assign is not saved until you click Apply or OK.

Keep Alive Timeout (seconds)
Default = 120 seconds

Use this option to set the amount of time in seconds that this
DeviceMaster waits until it closed this connection and frees all the
ports associated with it. The Keep Alive feature works in the
following way.

During normal operation the driver periodically sends a connection
check to the DeviceMaster, and the DeviceMaster then returns a
response. There are two timers: one in the driver, and one in the
DeviceMaster. These timers are reset when a connection check
signal is received. If a connection is broken, that is, a check is not
received, the data is stored in the computer and/or the
DeviceMaster. Depending on the amount of time that has expired
since the connection was lost, the following happens:

e  When the computer loses its connection to the DeviceMaster but
re-establishes it before the time-out period expires, any data
transmitted during this period is queued and sent when the
connection resumes.

¢  When the computer loses its connection to the DeviceMaster
and does not re-establish it before the time-out period expires;
the driver then purges any pending I/O data for ports on that
connection and returns all pending, and future I/O commands,
with the exception of the Close command, to the application with
an error indicating the disconnected status.

This is similar to the processing which occurs when the
computer receives a notification from the DeviceMaster that a
port release request was processed on a port it owns with the
exception that a different status is returned. When the
connection is re-established, the computer will attempt to re-
acquire the ports that were open when the connection was lost.
If the attempt is successful, normal operations resume for the
port. If any port fails to be acquired, then the computer will
continue to fail all further I/O operations, with the exception of a
Close request. When the Close request is received, the port can
then be re-opened.

e Ifthe computer loses its connection and the time period expires,
the DeviceMaster places the port into a state that another
computer can establish a connection, locking out the original
driver when a connection is made. The driver will respond to all
I/0 commands, with the exception of the Close command, with
an error indicating the disconnected status. If the port is still
available when the driver re-establishes a connection, then it
will claim the port and allow I/O to resume.
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Device General Tab Description

Use the TCP Timeout Multiplier option to modify two timers used in
TCP/IP socket communications.

The first identifies how long the TCP protocol should wait before
timing out an attempt to open a TCP channel. The TCP Timeout
Multiplier default is 1 and the timer defaults to 500 ms when the
TCP/IP address method is used to communicate with a device.

TCP Timeout Multiplier If the TCP Timeout Multiplier is set to 2, the timer would now be
1000 ms, or 1 sec. If the multiplier is 4, the new time-out period
Default = Tms would be 2000 ms, or 2 sec.

The second timer defines how long the driver will wait for a
response from the DeviceMaster when a forced release of a port is
requested. This timer defaults to 8 seconds.

If the TCP Timeout Multiplier is changed to 2, the timer would now
be 16 seconds. If the multiplier is 4, the new time-out period would
be 32 seconds.

Typically, you should leave the scan rate set to the default value (10

ms) for most applications. To adjust latency for time-critical

Scan Rate (ms)] applications, select a longer or shorter interval from the droplist, or
type in the rate (2 to 50). If a value larger than 50 is entered, the

Default = 10ms maximum of 50 is implemented.

Note: The faster the scan rate (lower number), the higher the load
on the system processor.

Number of Devices to Load at | This field determines how many DeviceMasters will have firmware

Once loaded by the device driver at one time. Increasing the number will
increase network traffic, decreasing the number will decrease
Default = 20 network traffic but may increase total load time.

Click this option if you do not want the device driver firmware to

upload to the DeviceMaster.
Do NOT Attempt to Load . . .
Firmware to the Device You may want to use this option when custom firmware is loaded as

. the default application.
Default = Disabled

The custom firmware must support communications with the device
driver if you want to access the ports as Windows COM ports.

Verbose Event Log Selecting this option causes detailed messages to be sent to the
. operating system Event Log. This added information can be useful
Default = Disabled when debugging communications and configuration problems
Click Save Configuration to save the Device Settings for use on
Save Configuration another similar Comtrol device or to archive a copy of your

environments settings.

Click to Load Configuration to load the Device Settings previously
saved using the Save Configuration feature.

. Note: Configuration files must be for the same model with the same
Load Configuration port density. For example, you cannot load a DeviceMaster
PRO configuration file onto a DeviceMaster RTS or a
configuration file for a 32-port DeviceMaster RTS onto a 4-
port DeviceMaster RTS.

Ok Click Ok to save the changes made on this page and close the
Comtrol Drivers Management Console.

Cancel Cancels any changes made on this page.

Click Apply to save the settings on this page. If you do not click
Apply Apply before leaving this page, you will be prompted to Apply or
Cancel the changes.

Defaults Resets this screen to its default values.
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Configuring COM Port Properties

This section discusses COM port configuration procedures for DeviceMaster NS-
Link ports. If you want to change the starting NS-Link COM port number on the
DeviceMaster, see Configuring Device Properties on Page 40.

If your application does not set COM port properties, use the Device Manager to
access Ports (COM & LPT) to change the port parameters. If the application sets
COM port properties, those settings take precedence over Windows COM port
settings. The exception to this guideline is if you use the Override and Lock Baud
Rate to option.

Use the following procedure to change NS-Link COM port settings on a
DeviceMaster port or ports.

type has been configured in the driver. The driver default port setting
is RS-232.

1. Open Comtrol Drivers Management Console (Page 31).

i Do not connect RS-422/485 devices until the appropriate port interface

Caution

2. Highlight the appropriate DeviceMaster.
3. Highlight the first port you want to configure.

G Comtrol Drivers Management Consaole @

E] DeviceMaster Gereral |
& DeviceMaster LT, 16 Port
- DeviceMaster RTS, 4 Port Port Settings
] -4 DeviceMaster Serial Hub, 8 Port RS Mode: 232 - —
- %eEE PRO - Rocketlink Console Ports e T Options
¥ £58510 (COM103) werride and Lock Baud Rate to: lone -
- Esss0s (coM108) Transmit Data Timeout on Port Close: 0 = (seconds)
& porto3 (coM1z)
5 Es8510%7E (Com110) [CMap 2 Stop Bits to 1
;j [ wait on Physical Transmission before Completing Write
7 Es7510 (COM104) ["]Emulate Modem Hardware RING Signal
y Port 07 (COM20) [ Allow Parity Conflict (DeviceMaster 1 Port only)
(y Port 08 (COM109) [ Block Plug-M-Play Search for Attached Serial Device
- RocketPort Infinity/Express
RocketPort/RocketModem

Clone

[] Apply These Settings to All Ports

Paort Mame

UserFriendly Port Name: ~ ES8509-XT

COM Mame: _CDMJ.UZ bd

[~ Renumber All Subsequent Ports Relative to This Port

Comtrol Drivers Management Console version 2.11

Copyright {C) 2011-2013 Comtrel Corperation. Save Configuration ] [Luad Configuration ] [ oK ] [ Cancel Apply
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4. Select the appropriate communications mode.

Note: The DeviceMaster Serial Hub only supports RS-232. If you select RS-
422 or RS-485 on the DeviceMaster LT, you may want to configure
Terminator Resistor options. If so, click the Terminator Resistor Options
button.

e Comtrol Drivers Management Conscle

Eh--y- DeviceMaster General |
[=)--%@Ems DeviceMaster LT, 16 Port
e M Port 01 (COM11) Port Settings
j e e RS Mode: "~ [ ——
- ar . 232 Options
" M Port 04 (COM13) Override and Lock Baud Rate to: m
(,é_f_i Port 05 (COM21) Transmit Data Timeout on Port Close: ﬁ: Eﬂ"’e) Siave)
s Port 06 (COM24) ire, Slave
e g; Port 07 (COM25) [] Map 2 Stop Bits to 1 455 (4-wire, Master)
(y Port 08 (COM26) [ wait on Physical Transmission before Completing Write: ; - -
e S Port0s (com3s) [] Emulate Modem Hardware RING Signal This option is only available
e M Port 10 (COM36) [] Allow Parity Conflict (DeviceMaster 1Portonly) ORI the DeviceMaster LT.
(;_;_i Port 11 (COM38) [ Block Plug-H-Play Search for Attached Serial Device
3 oo
- 5 Port 13 (COM40)
' port 14 (coma1) iz
- S Port 15 (Com42) [”] Apply These Settings to All Ports
- 5 Port 16 (COM43)
& DeviceMaster RTS, 4 Port Port Name
A8 DeviceMaster Serial Hub, 8 Port User-Friendly Port Name:  Port01
- %gEm PRO - Rocketlinx Console Ports
RocketPort Infinity/Express COM Name:
- RocketPort/RocketModem
[T Renumber All Subsequent Ports Relative to This Port

Comtrel Drivers Management Console version 2,11

Copyright (C) 2011-2013 Comtrol Corporation. [Save Configuration ] [Lnad Configuration ] [ OK ] [ Cancel ] Apply

Make the appropriate selections to reflect your configuration.

Terminator Resistor Options

NOTE

‘fou may use one or both of these two options to improve the integrity of the signal
on a long distance high-speed R5-422 or R5-485 network.

Using these options you can place a 120 O termination resistor between each of
the transmit differential pair or receive differential pair on every portin R5-422 or
RS-485 mode.

If enabled, termination resistors will be placed between the signals shown below:
*RS5-422 mode:

- Between TxD+ and TxD-
-Between RxD+ and RxD-

*R5-485 mode (4-wire):
-Between TxD+ and TxD-
- Between RxD+ and RxD-

*R5-485 mode (2-wire):

-Between TxD+ and TxD-
T DeviceMaster LT, Only
- It does NOT apply.

|:| Tx Terminator Resistor

|:| Rx Terminator Resistor

[ Defaults ][ OK ][ Cancel ]

5. Enable the features that you require for your environment.

Note: You can use the help system or refer to the following table for
information about each option.
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6. Optionally, click the RTS Toggle Options button:

¢ Ifyour communications application does not toggle FTS when transmitting
in RS-485 mode.

* Ifyouare using an  ror e ——
RTS Toggle Options ) 21xl
external RS-232 to Ly
RS-485 converter’ MOTE: ‘You may need to use one aor more of the settings below in any of the Fallowing
which is attached to cases:
a pOI‘t that 18 -- If your communications application doesn't taggle RTS when transmitting in
configured for RS- RS-465 mods,
232 . -- If ywou are using an external RS-232 to R5-485 converter attached to a port
Cl k th configured in R3-232 mode,
a. 1C e
appropriate options
fo%'pyogr p [~ Owverride and Lock to R5-485 Toggle Made
environment. [~ RS-485 Toggle RTS Low
b. Click OK to save
the Changes and Defaulks | QK I Cancel |

return to the port
General tab.

7. If desired, click the Clone check box to set all of the ports on this Comtrol
device to these characteristics.

8. Optionally, change the User-Friendly Port Name.

9. Ifdesired, select a different COM Name (NS-Link COM port number). The
drop-down list displays (in use) next to COM port numbers that are already in
use in this system. Do not duplicate COM port numbers as this will cause the
ports to not function.

10. Click Apply to save these changes.

Note: If you selected RS-422 mode, make sure that there is not a device
attached to the port and click OKk.

11. Highlight the next port that you want to configure and perform Steps 4
through 10.

The following table provides detailed information about the options on the port
General tab.
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Port Settings General
Tab

Description

RS Mode

Default = RS-232

Use this drop-down list to select the communications mode for the
serial device that you will be connecting to this port.

e RS-232
e RS-422
e RS-485 Mode provides these choices, depending on the model.

Note: The DeviceMaster LT and DeviceMaster RTS 2-port
models support RS-485 4-wire, Slave or Master. The
DeviceMaster PRO and other DeviceMaster RTS models
only support RS-485 2-wire.

- RS-485 2-wire (half-duplex) supports transmit and receive
data. When data is transmitted, the Transmit Enable signal
is activated, and the transmit receive device switches from
receive to transmit automatically.

- RS-485 4-wire Master (full-duplex master) supports transmit
and receive data, which means both signals are always
active. The DeviceMaster is enabled by the Transmit
Enable signal. This mode is the same as RS-422.

- RS-485 4-wire Slave (full-duplex slave) supports transmit and
receive data. When data is transmitted, the Transmit
Enable signal is activated, the transmit device goes active
and starts sending data. When the data is not being sent,
the transmit device is inactive. The receive device is always
active. If you click RS-485, you may need to change settings
in the RTS Toggle Options screen.

Note: The DeviceMaster Serial Hub default value is RS-422, the
default value is RS-232 for other DeviceMasters.

Override and Lock Baud Rate
to

Default = None

This option allows you to lock selected ports.

You can select a value from the drop-down list or enter an
appropriate value from the following standard baud rates: 300, 600,
1200, 1800, 2400, 3600, 4800, 7200, 9600, 14400, 19200, 38400,
57600, 115200, 230400, 460800, or 921600.

After locking a baud rate, no matter what baud rate is selected in a
host application, the actual rate used is the rate specified here.

RTS Toggle Options

This button opens the RTS Toggle Options popup, which provides
the following features:

® Override and Lock to RS-485 Toggle Mode

Use the Override and Lock to RTS Toggle Mode option to lock the
port in RTS (Request to Send) toggle mode, then set the mode
(low or high) as desired for RS-485 mode.

* RS-485 Toggle RTS Low

Use the RTS Toggle RTS Low option to toggle the RTS output
signal low during data transmission, which may be needed for
relay devices for RS-485.

If the option box is not checked, RTS is toggled high (asserted)
during data transmission for RS-485 mode.

e Defaults

Clicking the Defaults button returns all the values in the RTS
Toggle Options popup to their default state:

- Override and Lock to RTS Toggle Mode = Disabled
- RTS Toggle RTS Low = Disabled
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Port Settings General
Tab

Description

Terminator Resistor Options
(DeviceMaster LT, Only)

Optionally, click the Terminator Resistor button to enable
termination resistors.

To ensure the best signal integrity on a long distance high-speed
RS-422 or RS-485 network, sometimes it is required to place a
120€) termination resistor between each of the transmit differential
pair or receive differential pair.

Signal reflection is reduced and a reliable communication is
ensured by placing the 120( termination resistor. The
DeviceMaster LT provides software controllable 120€) termination
resistor for each differential pair on every port in RS-422 and RS-
485 mode. Use the Termination Resistor Options popup to place
120Q) termination resistors between the signals shown below:

e RS-422 Mode

- Between TxD+ and TxD- (Pins 5 and 7)
- Between RxD+ and RxD- (Pins 4 and 2)

e RS-485 Mode — Between TxD/RxD+ and TxD/RxD- (Pins 5 and
7

Transmit Data Timeout Port
Close

This option allows you to select the length of time to wait for data to
clear the transmit buffer after a host application has closed the
port. This is typically used with serial devices such as printers, to

Default = 0 give the data sufficient time to flush through the system.
If your application is hard-coded to use two stop bits and you
Map 2 Stop Bits to 1 receive framing errors, click this check box to map 2 stop bits to 1

Default = Disabled

bit.

Leave this check box blank to enable stop bits to pass through
unchanged.

Wait on Physical Transmission
before Completing Write

Default = Disabled

This option forces all write packets to wait until the transmit data
has physically completed the transmission before returning
completion to the host application.

The default mode (check box not clicked) is to buffer the data in the
transmit hardware buffer, and return completion as soon as the
packet is in the buffer.

Emulate Modem Hardware
RING Signal

Default = Disabled

Click this check box to emulate the ring indicator signal.

If this box is checked and the port receives a RING signal (or an
alternate code, as defined in the AT command set for the modem), it
sends an RI signal to the communications application.

Block PnP search for attached
serial device

Default = Disabled

This option disables plug and play from searching for a device
attached to the serial port.

For example, data received during device discovery on a device is
assumed to be a mouse to plug and play.

Allow Parity Conflict
(DeviceMaster 1-Port only)

Default = Disabled

Use this option to allow a parity conflict on a DeviceMaster 1-port.
It may be necessary to use this option after you have determined
that the cabling is correct and you are able to transmit data but not
receive proper data.

Clone: Apply all the settings to
all ports

Default = Disabled

If this check box is not clicked, changes apply to the selected port
only.

If this check box is clicked, changes apply to all ports on this board.

User-Friendly Port Name

You can enter a custom COM port name to identify this
DeviceMaster in the Comtrol Drivers Management Console.
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Port Settings General
Tab

Description

COM Name

The COM Name drop list allows you to renumber this COM port. If
you see a COM port number followed by (in use), this means that
Plug and Play sees those COM port numbers in use by another
device.

If you renumber this COM port and click the Renumber All
Subsequent Ports Relative to The Port option, the device driver will
renumber all of the ports on the DeviceMaster, starting with the
number you select in this drop list.

If you rename the port to a COM name used by another port, a
dialog appears indicating that the port is already in use.

Renumber All Subsequent
Ports Relative to the Port

Default = Disabled

Use the Renumber All Subsequent Ports Relative to This Port option to
renumber all subsequent ports on the DeviceMaster relative to the
port displayed in the COM name drop list.

Defaults
Default = Disabled

Click the Defaults button to return to the driver default values.
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Network Configuration in Comtrol Drivers Management Console

Comtrol recommends using PortVision DX to configure network settings.
Optionally, you can use the Comtrol Drivers Management Console to:
¢ Disable IP communications.

¢ Change the IP address (if the MAC address has been associated to the
DeviceMaster), see Changing a Static IP Address on Page 50.

¢ Configure the DeviceMaster for use with DHCP, see Setting Up DHCP on Page
51.

Disabling IP Mode Use this procedure if you want to disable IP communications.
1. If necessary, access the Comitrol Drivers Management Console.

Note: The DeviceMaster must be operational in MAC mode on a local network
segment or connected directly to the PC (Associating the MAC Address

on Page 36).

2. Make sure that the MAC Mode radio button has been selected.
3. Highlight the Device Name of the 2]

DeviceMaster that you want to

configure.

. | Disable 1P

4. Click the Network Settings button. R
5. Click the Modify button.  Static 1P

6. Click Disable IP.

IP Address: I 192.1658.11.20

You can use the Disable IP option if you S
are not using IP addressing (DHCP or
static) and operating the DeviceMaster Gateway: [152.18.11.1
in MAC mode.
MDdiFkJ Apply Changes ”WI
% Disable 1P
" DHCP IR
" Static IP

1P Address: I 192,168.11.20
Subnet Mask; I 255,255.0,0
Gateway: I 192.168.11.1

Iodify: | Apply Chan%\s I Close |

7. Click the Apply Changes button.
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8. Click Yes to the Warning popup.
After the DeviceMaster is rebooted,

the following occurs:
In PortVision DX, the IP address

arnine ]
Y¥ou have selected to disable DHCP and static IP access to the DeviceMaster!

Do you wank ko conkinue?

displays as 0.0.0.0. W |

In the Comtrol Drivers

Management Console:

The IP address in the Network Settings popup displays 255.255.255.255.
If the DeviceMaster had been set to IP Mode, the previously programmed
IP address will appear in the IP Mode text box. You can delete the IP
address from the IP Mode text box and click Apply to clear the IP address
from the text box.

9. Click Close to return to the Comtrol Drivers Management Console.

After disabling IP communications, you may need to do the following:

Configure device properties, see Configuring Device Properties on Page 40.

Configure COM port properties, see Configuring COM Port Properties on
Page 43.

Configure any of the DeviceMaster ports as sockets, see Configuring
DeviceMaster Ports as Sockets on Page 53.

Changing a Static IP Typically, PortVision DX is used to program the IP address into the DeviceMaster

Address during initial configuration. After associating the DeviceMaster with the MAC
address you can change the IP address using the Comtrol Drivers Management
Console.

1.

SO

Before programming an IP address it is critical that the DeviceMaster be
operational (the PWR or Status LED is lit) when configured for the MAC
address (Associating the MAC Address on Page 36).

Note: If the DeviceMaster is NOT operational, do NOT attempt to program or

Highlight the Device Name of the -
DeviceMaster that you want to bl LR ' 2x|
configure.

. . = Disatle 17
Click the Network Settings button. P
Click the Modify button. e
Cth Statlc IP . . . IP Address: IW
Enter static IP address information in o
the fields below.  [zsszs500

. atemay I—

a. IP Address: Enter a valid IP address S e

use an IP address with the DeviceMaster.

for your network. The IP Address
field is the IP address programmed
into the DeviceMaster after - e 5|
applying the changes and rebooting i QJ TN |

the DeviceMaster. See your network
administrator for a valid IP address.

Mask: The subnet mask is a 32-bit value (255.x.x.x) that enables IP
packets to distinguish the network ID and host ID portions of the IP
address that filters traffic.

Gateway: The default gateway is a TCP/IP configuration item that is the IP
address of a directly reachable IP router.
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Setting Up DHCP

10.
11.

12.

Click Apply Changes to begin : - =
programming the DeviceMaster. ]
Click Yes to the WARNING popup 7 T
message. " DHCP IP

warning B G Static IP

The IP address specified will set to device

(9 ot b s 1P Address: I 192,1658.11 .20|
Subnet Mask: I 255,255,0,0
es Mo |
Gateway: I 192,1658.11.1

Click Yes to the next WARNING popup
message about rebooting the

DeVlceMaSter- [adify I Applychangesl Close |
warniv =

In order ko communicate with the device using the
new IP address, the device must be reset,

Do you want to reset the device now?

Ve; I Mo |

If you do not reboot the DeviceMaster at this time, the IP address is not
implemented on the DeviceMaster. Failure to reboot at this time can cause
network communication problems later, if the IP address is not programmed
into the DeviceMaster. Comtrol support recommends rebooting the
DeviceMaster at this point.

Click Close to return to the Device General tab.

Optionally, you can click the Advanced tab and verify that the Device Status
message indicates that the Device is active and Ok.

After programming the IP address, you may need to do the following:

¢ Configure device properties, see Configuring Device Properties on Page 40.

¢ Configure COM port properties, see Configuring COM Port Properties on
Page 43.

¢ Configure any of the DeviceMaster ports as sockets, see Configuring
DeviceMaster Ports as Sockets on Page 53.

After associating the DeviceMaster with the MAC address you can configure the
driver to work using DHCP.

1.

w

Before programming an IP address it is critical that the DeviceMaster be
operational (the PWR or Status LED is lit) when configured for the MAC
address (Associating the MAC Address on Page 36).

Note: If the DeviceMaster is NOT operational, do NOT attempt to program or
use an IP address with the DeviceMaster.

Highlight the Device Name of the DeviceMaster that you want to configure.
Click the IP Mode radio button.
Click the Network Settings button.
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5. Click the Modify button.
2 x|

= Disatle 17
€ BHER I
£ Static 1P

1P Address: I 192,168.11.20
Subnet Mask: I 755,255,0,0
Gateway: I 192.168.11.1

Modif‘: | Applychangesl Close I

6. Click DHCP IP. This option allows 2]

DHCP to assign the IP address. Make
sure that you provide the MAC address

of the DeviceMaster for the network © Disable TP
administrator to assign a static IP = DHCPIP
address from the pool. The DHCP  static 1P

server should assign the IP address,

mask, and IP gateway. 1P address: [152.168.11.20
7. Click Apply Changes. subnetMaski [5oinn

8. Click Yes to the WARNING popup Gateway: [[152.165.11.1
message.
warning X
The IP address specified will enable DHCP and disable static IF access Madify: I Apply CH~oges | Close |

Do you wank ko conkinue?
o |

9. Click Yes to the next WARNING popup

message. warnin x|
. . d i ith the devi ing th
If you do not reboot the DeviceMaster at this e s

time, the IP address is not implemented on
the DeviceMaster. Failure to reboot at this

time can cause network communication Mo |

problems. Comtrol support recommends

Do you want to reset the device now?

resetting the DeviceMaster.
After the DeviceMaster reboots, the following occurs:

e The Comtrol Drivers Management Console displays the IP address (0.0.0
and subnet mask (255.255.0.0) values in the Network Settings popup.

e PortVision DX will display the IP address assigned by DHCP.
10. Click Close to return to the Device General tab.

.0)

11. Optionally, you can click the Advanced tab and verify that the Device Status

message indicates that the Device is active and Ok.
12. After programming the IP address, you may need to do the following:

¢ Configure device properties, see Configuring Device Properties on Page 40.

¢ Configure COM port properties, see Configuring COM Port Properties on

Page 43.

¢ Configure any of the DeviceMaster ports as sockets, see Configuring
DeviceMaster Ports as Sockets on Page 53.
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Configuring DeviceMaster Ports as Sockets

DeviceMaster ports can also be configured as sockets. To configure sockets, use the

following procedure:

1. Use one of these methods to open the socket configuration web interface

(SocketServer).

¢ In PortVision DX, right-click the DeviceMaster and click Webpage.
¢ Enter the IP address of the DeviceMaster in your web browser URL field or

highlight the DeviceMaster in PortVision DX and click Web Manager.

2. Click the port number that you want to configure as a socket.

P N
ﬁg| & hitp://19216811.23/home.asp

| (& Comtrol Corporation - Dev.., ‘

[l o=

o1

Network Enabling Devices

| Network || Securnity || EMail || REC1006 |

Server Status @

Software:
Host Name:
IPv4 Config:
IPv4 Address:
IPv4 Netmask:
3 : IPv4 Gateway:
DEV|CEMASTER IPv6 Config:
IPv6 Address:
IPv6 Gateway:

Connection Status

NS-Link 9.11

Static

192.168.11.23

255.255.0.0

192.168.11.1

Disabled

FEeF - - - FFF £ FFF: FFFF - /255
liiiBiiHiiid i gdiis i

Port Name: -' ] !r’inter

Port 2 Port 3
Bar code reader Scanner

Port

m

See the web page help system, if you need information about configuring sockets
or serial tunneling. Optionally, you can refer to the DeviceMaster Installation and

Configuration Guide.

The web page help is also available separately if you want a local copy on your
host system. The help files are on the Software and Documentation CD and the

latest version can be downloaded at: ftp:/ftp.comtrol.com/dev_mstr/rts/software/

SocketServer/help/ssvr help.zip.
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Enabling Secure Data Mode

In addition to enabling SSL mode in the driver, you must Enable Secure Data Mode

in the NS-Link web page. Use the following procedure to implement the Enable
Secure Data Mode option.

1. Access the NS-Link web page using one of these methods:
¢ Open your web browser, enter the IP address, and click enter.

¢ Right-click the DeviceMaster in the Device Tree or Device List pane in
PortVision DX and click Webpage.

2. Click the Security tab.
3. Click Enable Secure Data Mode and Save.

y ” S
Q‘ -|;g|m|: /192,168,123 /securityCfg.asp pP-2e x| ) ok 1

‘ (2 Comtrol Corporation - Dev... | ‘

Network Enabling Devices

[ Server Stams || Network | EMail || RFCI006

m

Security Configuration

Enable Secure Data Mode U

Enable Secure Config Mode
Enable Telnet/ssh v

Enable Monitoring Secure Data via Telnet
Enable SNMP

Unda Changes

€ T

4. Configure your security key and certificate and click Set.

Key and Certificate Management

RSA Key pair used by SSL and SSH servers factory Iﬂl
RSA Server Certificate used by SSL servers factory Iﬂl
DH Key pair used by SSL servers factory  Set |
Client Authentication Certificate used by SSL servers none [ Set |

Click the Help button if you need information about key and certificate
management.
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The Comtrol Drivers Management Console supports saving device driver

configuration files, which provides:

e Back-up for existing driver configuration settings

e Ability to configure multiple of the same devices with the same configuration
parameters

e Save the driver configuration settings because you need to remove a driver
version to install a new driver version and you want to reload the driver
configuration settings into the new driver

Note: Configuration files must be for the same model with the same port density.
For example, you cannot load a DeviceMaster PRO configuration file onto a
DeviceMaster RTS or a configuration file for a 32-port DeviceMaster RTS

onto a 4-port DeviceMaster RTS.

Configuration files are saved with a .DCF extension.

Saving Driver Configuration Files

Use the following procedure to create and save a configuration file.

1. After configuring the device and ports, click Save Configuration.

& Comtrol Drivers Management Console

-+ DeviceMaster General | Advanced

-4 PRO - Conscle Ports

[+ NEmE DeviceMaster Serial Hub, 8 Port Metwork Connection Mode

e I MACMede | 00CO 4 07FF FC p

= Rk iy oress :
[+ BB} EXPRESS 8P @) IP Mode 192.168.11.23
-~ RocketPort/Rockettodem [FlEnable SSL Mode =
- BB Rocketport o, 1Pl Quac/Octa
M Rockn Rt s, QU O [T server Certificate
Client Certificate: %
Device Settings
Device Name: DeviceMaster RTS, 4 Port
User-Friendly Device Name:  DeviceMaster RTS, 4 Port
Keep Alive Timeout (seconds): 120 (Default: 120)
TCP Timeout Multiplier: 1 (Default: 1)
Scan Rate (ms): 10 ~ (Default: 10)
humber of Devices toLoad at Once: 20 (Default: 20)
Do NOT Load Firmware to Device [
Verbose EventLog [ (Troubleshooting Only)
—

Comtrol Drivers Management Console version 2.00 \
Copyright (C) 2011-2012 Combrol Corporation. Save cﬂnﬁgma[sn flosd Configuration | [ ok | [ cancel | [ apoy | [ heb |
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2.

Optionally, change the default file name and click Save.

& Savehs
\:/U [J « 1.Work Files » Backup_Config_Files ~ [ 6 ][ search Backup_c
e
e Name Date modified Type
B Desktop 5] PRO-Console Ports.DCF 3/13/201310:02 AM  DCF File
i Downloads
U] Recent Places |-
4 Libraries
<] Documents
& Music
[ Pictures
B Videos
1% Computer >4 ! D
(NN . i ceMaster Serial Hub, 8 Port.DCH] -
Save as type: Driver Canfiguration File (*.DCF) -
' Hide Folders Cancel

Loading a Driver Configuration File

Loading Device
Configuration

You must have previously saved a configuration file before you can load a
configuration file.

The driver configuration file uploads in portions:

If you highlight a device and click Load Configuration and Apply for the device-
level configuration parameters to reload on the device.

To load port-level configuration parameters, you must highlight a single port
and click Load Configuration and Apply. You must upload each port's
configuration parameters separately.

Use the following procedure to load the configuration file for device-level
information for your device.

1.

If necessary, open the Comtrol Drivers Management Console using one of these
methods:

e  Windows Control Panel; go to your Control Panel and click on the
Comtrol Drivers Management Console.

e  Shortcut; located under Start > Program Files > Comtrol > Product_Name >
Comtrol Drivers Management Console.

Depending on your operating system, you may need to click Yes to the Do you
want to allow the following program to make changes to this computer? User
Account Control message.
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3.

level settings from the configuration file.

In the left pane, highlight the device for which you want to load the device-

& Comtrol Drivers Management Console

..... S essacia-feerIl)
- Es8505 (COM108)
& Porto3 (coms)
¥ Porto4 (coms)
- Es8509-XT (COM102)
A E57510 (COM104)

¥ Porto7 (comMs)

- Es8s08F (COM109)
B DeviceMaster Serial Hub, 8 Port
¥ Porto1(comin)

S Portoz (com12)

& E57510-XT (COM107)
¥ Es7528 (com101)

- ES7508 (COM100)

- Es9528 (COM105)

¥ ES8510-XTE (COM106)
A Portos (comis)
e DeviceMaster RTS, 2 Port, 25
¥ Porto1 (comzs)

A Portoz (comze)
RocketPort Infinity/Express

= BB EXPRESS 8P

¥ porto1{comM1n

- General | Advanced

Network Connection Mode

(F)MACMode  00CO4E 17FFFB

@) IP Mode 192.168.11.20
[7]Enable SSL Mode:

[T server Certificate

Client Certificate:

m

Device Settings
Device Name:

User-Friendly Device Name:

Verbose EventLog

Network Settings
Reboot Device

DeviceMaster PRO, 8 Port

PRO - Console Ports

Keep Alive Timeout (seconds): 120 (Default: 120)
TCP Timeout Multiplier: 1 (Default: 1)
Scan Rate (ms): 10 ~ (Default: 10)
Number of Devices to Load at Once: 20 (Default: 20)
Do NOT Load Firmware to Device [

[] (Troubleshosting Only)

Defaults

Comtrol Drivers Management Console version 2.00
Copyright (C) 2011-2012 Comtrol Corporation.

Save Cunﬁguranunﬂ Load Eunﬁgurahun X

few moments.

Make the appropriate

ok | [ cancel | Apply [ reb ]
Click Load Configuration.
Browse to the location of the configuration file that you want to load.
Highlight the configuration
file and click Open. The € open =
conﬁguration ﬁle loads in a Gu [ )1 « 1_Work_Files » Backup_Config_Files = \&,H Search Backup_Config_Files 0 |
Organize » Mew folder = O @
e Name ’ Date modified
. . . Bl Desktoy \Z] PRO-Console Ports.DCF 3/13/2013 10:02 AM
choice for your situation: R Dorloats :

Click No to the
ComitrolApplet message,
if you are using the file
to set up multiple
devices with the same
device-level settings.

Click Yes to the
ComtrolApplet message,
if you are using the file
to restore a specific

%l Recent Places

1

4 Libraries
=] Documents
& Music
|5 Pictures

B videos

18 Computer
&, Local Disk (C)

&
S downloads (Vsidewinder) (@) = < |

m ]

b

File name:  PRO-Consele Ports.DCF

~ | Driver Configuration File (*.DCF +
Lo I

device. For example,

you needed to remove and then re-install the DeviceMaster NS-Link device

driver.

ComtrolApplet

¢ -“ "MAC address”,

"IP address", "User-Friendly Device Mame" may conflict
¥’ with your current settings.

Do you want to load these settings?

8. Click Apply so that the configuration is saved on the device.

9. Go to the next procedure if you want to restore port settings from a

configuration file.
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Loading Port
Configuration

Use the following procedure to load the configuration file for port-level settings for
your device.

Note: Device driver configuration files must be for the same model with the same

port density. For example, you cannot load a DeviceMaster PRO
configuration file onto a DeviceMaster RTS or a configuration file for a 32-
port DeviceMaster RTS onto a 4-port DeviceMaster RTS.

If necessary, open the Comtrol Drivers Management Console using one of these
methods:

e  Windows Control Panel; go to your Control Panel and click on the
Comtrol Drivers Management Console.

e Shortcut; located under Start > Program Files > Comtrol > Product_Name >
Comtrol Drivers Management Console.

Depending on your operating system, you may need to click Yes to the Do you
want to allow the following program to make changes to this computer? User
Account Control message.

In the left pane, highlight the port for which you want to load the port-level
settings from the configuration file.

4 Comtrol Drivers Management Console

- DeviceMaster - General |
- REEE PRO - Console Ports M
- Port Settings
-/ Esass (CoM108) RSMode: 232 -

- 2 Part 03 (COMS)
- 7 Port 04 (CoMs)

5 Es8s09-xT (coM102)
- 7 ES7510 (COM104)

- ¢ Port 07 (Coms)

4 EsssosF (coming)
R DeviceMaster Serial Hub, 8 Port
- & porto1comiy)

2 portoz (com1z)

- ES7510-4T (COM107)

- Es7528 (com0n)
4 Es7505 (CoM100)

- 7 ES8528 (COM105)

- ¥ ES8510-XTE (COM108)

& portos (com1g)
R DeviceMaster RTS, 2Port, 2

- & port 01 (comas)
' portoz (comze)
- RocketPort Infinity/Express

(= EE# EXPRESS 8P
¥ porto1 icom1n

Override and Lock Baud Rate to: ~ None -

Transmit Data Timeout on Port Close: 0 - (seconds)

m

[C]Map 2 Stop Bits to 1

[]wait on Physical Transmission before Completing Write
[] Emulate Modem Hardware RING Signal

[7] Allow Parity Conflict (DeviceMaster 1 Port only)

[] Block Plug--Play Search for Attached Serial Device

B Defaults

Clone

[] Apply These Settings to All Ports

Port Name

User-Friendly PortName:  ES8510

COM Name: |COM103 .4

[CRenumber All Subsequent Ports Relative to This Port

Comtrol Drivers Management Console version 2.00
Copyright (C) 2011-2012 Comtrol Corporation.

Apply

[save Configuration | LuadEunﬁgurahun][ ok | [ cancel

Click Load Configuration.
Browse to the location of the configuration file that you want to load.
Highlight the

configuration file and click | €c= =
Open' The conﬁguration Gt [ 1) « 1_Work Files » Backup_Config_Files = [ ¢ || Search Backup_Config_Fites ]
file loads in a few Organize = New folder )
moments. o Name - Dete modified

B Desktop | =] PRO-Console Ports.DCF 3/13/2013 10:02 AM

18 Downloads

%] Recent Places

m

3 Libraries
% Documents
& Music
&= Pictures
B Videos —

™ Computer
&L, Local Disk (C)
s downloads (W\sidewinder) (Q) ~

< i ] r

- Driver Configuration File (*.DCF +
CoeF

File name: PRO-Consele Ports.DCF
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7. Make the appropriate choice for your situation:

¢ (Click No to the ComtrolApplet message, if you are using the file to set up
multiple devices with the same port-level settings.

¢ C(Click Yes to the ComtrolApplet message, if you are using the file to restore
a specific device. For example, you needed to remove and then re-install the
DeviceMaster NS-Link device driver.

ComtrolApplet 2

| "User-Friendly Port Name", "COM Name" may conflict with your
CW' current settings.
Do you want to load these settings?

Ly J[ Mgy

8. Click Apply so that the configuration is saved on the device.
9. Repeat Steps 3 through 8 for each port that you want to restore.
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Removing the DeviceMaster and Driver

This section discusses:

device driver from your system

Removing a DeviceMaster

Removing a DeviceMaster from an installation without removing the NS-Link

Removing the NS-Link Device Driver from your system

Use the following procedure to uninstall the device driver.

Note: Administrative privileges are required to remove device drivers on Windows
operating systems newer than Windows Server 2003.

1. Right-click the DeviceMaster that you want to uninstall in the Tree View

pane.

2. Click Uninstall.

G Comtrol Drivers Management Consaole

Disable
Uninstall

Properties

General | Advanced

Network Connection Mode
@ 00 CO 4E 40 FF FO

192.168.11.61

RocketPort/RocketMot

Enable S5L Mode
Server Certificate
Client Certificate:

Device Settings
Device Name:

UserFriendly Device Name:

Metwork Settings
Reboot Device

DeviceMaster LT, 16 Port

DeviceMaster LT, 16 Port

Keep Alive Timeout (seconds): 120 (Default: 120)
TCP Timeout Multiplier: 1 (Default: 1)
Scan Rate (ms): 10 ~ (Default: 10)
Mumber of Devices to Load at Once: 20 (Default: 20)
Do NOT Load Firmware to Device D
Verbose Eventlog [] (Troubleshooting Only) Defaults
Comtrel Drivers Management Console version 2,11
Copyright {C) 2011-2013 Comtrol Corporation. [Save Configuration ] [Lnad Configuration ] [ oK ] [ Cancel ] Apply
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Removing the NS-Link Device Driver

Use the following procedure to remove the DeviceMaster device driver.

1.
Comtrol > DeviceMaster > Driver

2.
Click Remove All and Next.

Comtrol Driver Installation wizard il

From the Start button, click the shortcut for your DeviceMaster: Programs >

Installation Wizard.

Click Next to start the Comtrol Driver Installation Wizard.

Install, Update, or Uninstall driver
Select the operation you wish to perform:

0 Instal
Select this option to install a new device and
update the associated driver(s).

" Update
Select this option to update the driver(s) for the
existing device(s).

& Remove Al

Select this option ko remove the existing device(s)
and uninstall al the associated driveris).

< Back | Nex§> I Proceed

Cancel

M

4. Click Next to remove the driver.

Comitrol Driver Installation wizard |

Device & Driver Clean-up

‘¥ou are about ta remave one or maore Canntrol device(s)
fram this computer. This remawval may resultin loss of
communication with the device(s) and ultimately disrupt
wour operations, if any.

This process will remaove all Comtrol hardware, from the
fallowing product Family, that reside on this PC and use
any version of this driver assembly.

Product Family: DeviceMasker

Click Mext to continue or Cancel o exit this wizard,

Cancel

< Back | N%xt> I Froceed
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5. Click Proceed to continue the driver removal process.
X

Summary

Driver Package :  DeviceMaster ;I
Selected Action :  Remove Al
Device(s) : All DeviceMaster Units

IT IS HIGHLY RECOMMEMNDED TO CLOSE ANY ACTIVE
SERIAL PORT/APPLICATION EEFORE YOU PROCEED,
FAILURE TO DO SO WILL RESULT IN DATA LOSS |

=

Launch Comtral Brivers Management Console I

Click Proceed ko continue or Cancel to exit this Wizard,

< Back | Text = I Proceedhl Cancel

)

6. Click the Reboot My Computer button or Close.
| Comtrol Driver Installationwizard Xl

Summary

Analyzing the COM Mame Arbiter ... ;I
Analyzing the Registry ...

Cleaning up the Remaining Driver Files ...

Finalizing ...

Finished.

REMINDER.: < SYSTEM REBOOT IS REQUIRED =
-

Launch Comtrol Drivers Management Consale I

Rebaoot My Computer |

|

Press Close ko exit this Wizard,

= Back | Tt | Froceed I Clase
bag

e Ifyou click Close, make sure that you reboot the system and remove the
adapter to complete the driver removal.

e If you click Reboot My Computer, click OKk.
x|

Flease make sure ka close your active programs and save your data,
. Click OK when yaou are ready to reboot the computer.

ol

7. Shutdown the system and disconnect the DeviceMaster from your network.
8. If you want to totally remove the .exe driver assembly:
a. Delete any copies of the .exe driver assembly file residing on the system.

b. Delete the driver and devices using the Add > Remove Programs Control
Panel.
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Troubleshooting and Technical Support

This section contains troubleshooting information for your DeviceMaster and the
NS-Link device driver. You should review the following subsections before calling
Technical Support because they will request that you perform many of the
procedures or verifications before they will be able to help you diagnose a problem.

Houw to Find Diagnostic Tools and Utilities
Troubleshooting Checklist on Page 66
General Troubleshooting on Page 67

Connectivity Requirements on Page 68
DeviceMaster LEDs on Page 70

Using the Advanced Tab on Page 72

NS-Link Driver Troubleshooting on Page 77
Using Port Monitor to Test Ports on Page 78
Using Test Terminal on Page 81

How Disable/Enable the Device Driver on Page 86
Technical Support on Page 87

If you cannot diagnose the problem, you can contact Technical Support on Page 87.

How to Find Diagnostic Tools and Utilities

There are several tools and utilities that Comtrol provides to diagnose serial port
problems or to monitor data.

The Advanced tab in the Comtrol Drivers Management Console (Using the
Advanced Tab on Page 72), which may provide valuable information about the
DeviceMaster and your network, in the event that you are having problems.

PortVision DX (Page 7) that provides the following features:

- Auto-discover and organize Comtrol Ethernet attached products on your
network.

- Remotely access, manage, and configure Comtrol Ethernet attached
products from a central console.

- Load network configuration settings onto multiple Comtrol Ethernet
attached products - quickly and easily.

- Instantly view connection status, firmware revision, and network settings
of all servers.

- Configure serial ports using TCP sockets, port communication, and
interface settings.

- Visualize each server and port with instant links to connector, power, and
serial pinout information.

- Conveniently customize and save your network view and commands for
replication across all servers.

- Includes the Test Terminal (WCom2) and Port Monitor (PMon2) programs
for easy access.

- Test Terminal can be used to troubleshoot communications on a port-by-
port basis.

- Port Monitor can check for errors, modem control, and status signals. In
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Troubleshooting Checklist

addition, it provides you with raw byte input and output counts

Test Terminal and Port Monitor are installed and available if you install
PortVision DX. You can refer to the Port Monitor and Test Terminal User
Guide for testing procedures.

Troubleshooting Checklist

Most customer problems reported to Comtrol Technical Support are eventually
traced to cabling or network problems.

Reboot the system and reset the power on the DeviceMaster, watch the PWR or
Status light activity. See DeviceMaster LEDs on Page 70 for information about the
diagnostic LEDs.

e Ifthe DeviceMaster has a power switch, turn the DeviceMaster power switch

off and on.

e Ifthe DeviceMaster does not have a power switch, disconnect and reconnect

the power cord.

PWR or Status LED Description
5 sec off, 3 flashes, 5 sec off, 3 flashes ... Redboot checksum failure.
5 sec off, 4 flashes, 5 sec off, 4 flashes ... SREC load failure.
5 quick flashes Ege default application is starting
10 sec on, .1 sec off, 10 sec on .1 sec off ... |The default application is running.

The following table may help you diagnose your problem:

Issue

Check

Cabling?

Verify that you are using the correct types of cables on the correct
connectors and that all cables are connected securely using the
DeviceMaster Installation and Configuration Guide (Page 7).

Network?

Isolate the DeviceMaster from the network by connecting the
DeviceMaster directly to a NIC in a host system.

See Connectivity Requirements on Page 68 for network
cabling information.

Reduce network traffic by installing a second NIC in the host
and connect directly to the DeviceMaster.

Verify that the Ethernet hub, switch, or router and any other
network devices between the system and the DeviceMaster
are powered up and operating.

Correct MAC
address?

Verify that the hardware MAC address in NS-Link matches the
address on the DeviceMaster label. You can also use PortVision
DX to verify the MAC and IP addresses.

Correct IP
address?

Verify that the network IP address is correct. If IP addressing
is being used, the system should be able to ping the
DeviceMaster.

Verify that the IP address programmed into the
DeviceMaster matches the unique reserved IP configured
address assigned by the system administrator.
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ftp://ftp.comtrol.com/dev_mstr/portvision_plus/docs/PortMon2_WCom2_Guide.pdf
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General Troubleshooting

Issue Check

If using the NS-Link device driver with an in-house application,
verify that you are addressing the port correctly. In many
applications, device names above COM9 require the prefix \\.\
in order to be recognized. For example, to reference COM20, use
\W\COM20 as the file or port name.

Correct port
addressing?

Is this the

Latest Driver? |S¢€ Checking the Device Driver Version on Page 22.

Test the Port Install PortVision DX (Page 11) and use Test Terminal (Page 81).

or Ports?

Comtrol Verify that the DeviceMaster has installed using the Comtrol
Drivers Drivers Management Console to confirm that the DeviceMaster
Management |displays. Install the device driver, if the DeviceMaster is not
Console? displayed.

Enable Enable the Verbose Event Log feature on the Device General and

Verbose mode |then reboot the system.

Note: If you have a spare DeviceMaster, try replacing the DeviceMaster.

General Troubleshooting

This table illustrates some general troubleshooting tips.
Note: Make sure that you have reviewed the Troubleshooting Checklist on Page 66.

General Condition Explanation/Action

Indicates that boot program has not downloaded to the
DeviceMaster.

1. If applicable, remove the NS-Link driver.

2. Make sure that you have downloaded the most
current driver from ftp:/ftp.comtrol.com/dev_mstr/

PWR or Status LED rts/drivers/win7.

flashing 3. Install the driver and configure the DeviceMaster
using the MAC address. Make sure that you reboot
the system. Refer to NS-Link Device Driver
Installation on Page 17 for installation
information.

Note: If the PWR or Status LED is still flashing,
contact Technical Support.

PWR or Status LED not |Indicates that power has not been applied or there is a
lit hardware failure. Contact Technical Support.
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General Condition

Explanation/Action

Can ping the Comtrol
device, but cannot open
the ports from a remote
location.

(You must have
previously programmed
the IP address, subnet
mask, and IP gateway.)

The NS-Link driver uses Port 4606 (11FE h) to
communicate with the DeviceMaster.

When using a sniffer to track NS-Link packets,
filtering for Port 4606 will easily track the packet. The
packet should also contain the MAC address of the
DeviceMaster and the originating PC so that it can be
determined if the packet is able to travel the full
distance one way or not.

If the 4606 packet is found on one side of a firewall or
router, using sniffer, and not on the other side, then
that port needs to be opened up to allow the 4606 to
pass.

This will most often be seen with firewalls, but is also
seen in some routers.

Cannot ping the device
through Ethernet hub,
switch, or router

Isolate the DeviceMaster from the network. Connect
the DeviceMaster directly to the NIC in the host
system (see Connectivity Requirements on Page 68).

Cannot ping or connect
to the DeviceMaster

The DeviceMaster family default IP address is often
not accessible due to the subnet masking from another
network unless 192.168 is used in the network.

In most cases, it will be necessary to program in an
address that conforms to your network.

If you do not use the NS-Link driver to program the IP
address, you only have 10 seconds to disable the
bootloader with Redboot to get into the setup utility.

See the DeviceMaster Installation and Configuration
Guide (Page 7) for the Redboot method of programming
an IP address.

Connectivity Requirements

An Ethernet connection: either to an Ethernet hub, switch, or router; or to a
Network Interface Card (NIC) in the host system using a standard Ethernet cable.
See the DeviceMaster Installation and Configuration Guide (Page 7) for
information regarding hardware installation.

Product Type Connected to |Connector Name
. Hub, switch,
DeviceMaster RTS 1-port router, or NIC 10/100 ETHERNET
. Hub, switch, RdJ45 port (not
DeviceMaster RTS Embedded router, or NIC  |labeled)
NIC
DeviceMaster RTS 2-port 1E Hub, switch, or |10/100
router
NIC
DeviceMaster RTS 2-port 2E Hub, switch, or |10/100 1E/2E
router
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Product Type Connected to |Connector Name
. NIC DOWN
DeviceMaster RTS 4/8/16-port -
(external power supply) Hub, switch, or |{;p
router
DeviceMaster RTS 16/32RM Hub, switch, 10/100 NETWORK
(internal power supply) router, or NIC
NIC DOWN
DeviceMaster PRO 8/16-port Hub, switch, or
router up
NIC DOWN
DeviceMaster Serial Hub 8-port [y, switch, or
router up
DeviceMaster Serial Hub 16-port | 222> sWitch, 174,100 NETWORK

router, or NIC

DeviceMaster Driver User Guide: 2000531 Rev. E Troubleshooting and Technical Support - 69



DeviceMaster LEDs

DeviceMaster LEDs

The DeviceMaster has network and port LEDs to indicate status.

Port LEDs

Port LEDs are amber and green on 4, 8, 16, and 32-port. The 1-port and 2-port

models do not have port LEDS. After a port has been opened in RS-232 mode, an
amber LED means that there is link between the port and the serial device. After
a port has been opened in RS-422 or RS-485 mode, an amber LED means that data
is receiving data. A green port LED indicates transmit activity.

Network and Device
LEDs

The LEDs indicate that the default DeviceMaster application, SocketServer is
running or after driver installation, that the NS-Link driver loads. If you have

loaded PortVision DX, you can check the DeviceMaster status on-line.

Ports Model

Network LEDs

1 DeviceMaster
RTS

The Status LED on the front of the unit is lit, which
indicates that it has power and has completed the
boot cycle.

Note: The Status LED flashes while booting and it
takes approximately 15 seconds for the
bootloader to complete the cycle. When the
Bootloader completes the cycle, the LED has a
solid, steady light that blinks approximately
every 10 seconds.

The red Link Act LED is lit, which indicates a
working Ethernet connection.

If the red Duplex LED is lit, it indicates full-duplex
activity.

If the red 100 LED is lit, it indicates a working 100
MB Ethernet connection (100 MB network, only).

DeviceMaster
1 RTS
Embedded

The LEDs are located between the RJ45 connector and
the power terminal block.

The amber Status LED (D1) on the adapter is lit,
which indicates that it has power and has completed
the boot cycle.

Note: The Status LED flashes while booting and it
takes approximately 15 seconds for the
bootloader to complete the cycle. When the
Bootloader completes the cycle, the LED has a
solid, steady light that blinks approximately
every 10 seconds.

The red Link Act LED (D2) is lit, which indicates a
working Ethernet connection.

If the red Duplex LED (D3) is lit, it indicates full-
duplex activity.

If the red 100 LED (D4) is lit, it indicates a working
100 MB Ethernet connection (100 MB network,
only).
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Network and Device LEDs

Ports

Model

Network LEDs

DeviceMaster
RTS

The STATUS LED on the device is lit, indicating you
have power and it has completed the boot cycle.

Note: The STATUS LED flashes while booting and it
takes approximately 15 seconds for the
Bootloader to complete the cycle. When the
Bootloader completes the cycle, the LED has a
solid, steady light that blinks approximately
every 10 seconds.

If the LINK (green) LED is lit, it indicates a working
Ethernet connection.

If the ACT (yellow) LED flashes, it indicates network
activity.

16

DeviceMaster

PRO (8)

DeviceMaster

RTSY

DeviceMaster
Serial Hub (8)

The PWR LED on the front of the unit is lit, which
indicates it has power and has completed the boot
cycle.

Note: The PWR LED flashes while booting and it
takes approximately 15 seconds for the
bootloader to complete the cycle. When the
Bootloader completes the cycle, the LED has a
solid, steady light that blinks approximately
every 10 seconds.

The red LNK/ACT LED is lit, which indicates a
working Ethernet connection.

If the red 100 LED is lit, it indicates a working 100
MB Ethernet connection (100 MB network, only).

16

32

DeviceMaster
PRO (16)

DeviceMaster
RTS++

DeviceMaster
Serial Hub
(16)

The Status LED on the front of the unit is lit, which
indicates it has power and has completed the boot
cycle.

Note: The Status LED flashes while booting and it
takes approximately 15 seconds for the
bootloader to complete the cycle. When the
Bootloader completes the cycle, the LED has a
solid, steady light that blinks approximately
every 10 seconds.

The red LNK/ACT LED is lit, which indicates a
working Ethernet connection.

If the red Duplex LED is lit, it indicates full-duplex
activity.

If the red 100 LED is lit, it indicates a working 100
MB Ethernet connection (100 MB network, only).

+ External power supply.
11 Internal power supply.
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Using the Advanced Tab

You can use the Advanced tab to get a summary of the DeviceMaster status. The
Advanced tab can be useful for troubleshooting network problems with your
DeviceMaster.

Note: To use the Advanced tab, you must associate a MAC address to the
DeviceMaster before programming an IP address (Page 36).

Use the following procedure to access the Advanced tab.

1. If necessary, access the Comitrol Drivers Management Console.
2. Highlight the DeviceMaster.

3. Click the Advanced tab.

Comtrol Drivers Management Console N 21|

DeviceMaster 1= General Adwanced |
= Ao Dg\_fi:eMaster PRO 8 Port {DeviceMaster PR

: F Port o1 (comil) ~Device Status
o S port 02 (Comiz)

;j Part 03 (COM13) Device is active and Ok, Refresh
7 port 04 (COML4)
o S Port 0 (Com1s) History
o S Part 06 (COMLE)
A port 07 (ComL7)
o S port 08 (Comie)

E| A Dg\_fi:eMaster RTS 4 Port (DeviceMaster RTS
7 Port o1 (comis)
o S Port 02 (Comzo)

j :: 33 Eggmgg PC Metwoark Interface Details
-~ RocketPort Infinity /Express o
- B RocketPort Express & Port, PC1e-BUS (Rocks LS eeten blsiscs La"sl
5 port 01 (Coms)
e S port 02 (Com4)
Port 03 (COMS)
F Part 04 (COME)

e S port 05 (Com7)
i

[~ Metwork Statistics

Port 06 (COME)

9 port 07 (oMY =
4 »

Comtrol Drivers Management Consale version 1,01
Copyright {C) 2011 Comtrol Corporation, Save Configuration | Load Configuration | oK I Cancel | Anly | Help

Note: You must have previously associated a MAC address to the
DeviceMaster (Associating the MAC Address on Page 36).

Refer to the Device Status table (Page 75) for a list of messages and
explanations.

4. You can click the History button to review the last ten actions on the
DeviceMaster.

2012-01-04 16:05:09  Code upload has completed,

2012-01-04 16:05:11  Device detected, initializing ...
2012-01-04 16:05:18  Initialization complete, Waiting on response from devio

2012-01-04 16:05:18  Device is ackive and O,

L bl

2012-01-04 16:17:19  Device detected, initializing ...
2012-01-04 16:17:50  Device detected, microcode upload in progress,

2012-01-04 16:17:59  Code upload has completed,

E
-~
a2l L
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5. Click PC Network Interface Details for the following information.

PC Network Interface 2xl

Statistic

MAC Address : FD 14 A0 30 63 44
Frames QOut W
Frames Accepted IW
Frames Passed On : lqzzm—

Adapter 1 ID String l‘\DE\"ICE'I,{?CDS?DE'D-SZ?Z-‘IF13-AF36-8085521EDCBE}

Help | Reset |

Field

Description

MAC Address

MAC Address is the reported MAC address of the Ethernet network
interface card (NIC) card in the server. Since a server may contain
more than one NIC, identifying exactly which NIC is being used by
the device driver may help you to identify and resolve problems.

Frames Out

Frames Out is the count of the number of frames output by the device
driver through the identified network interface. This includes all
administrative, data, and control frames, and should be incriminated
whenever the DeviceMaster and the device driver are operating, even
if the DeviceMaster is idle.

Frames
Accepted

Frames Accepted is the count of the number of received frames
accepted by the device driver for further processing. These must be
well-formed packets with the correct protocol identifiers for the device
driver.

Frames Passed
On

Frames Passed On is when a NIC receives a packet, it passes the
packet around to each driver or application that is bound to the NIC
until one of them recognizes and accepts the packet.

Adapter 1 ID
String

Adapter 1 ID String is the NIC binding string. Every network entity
that needs to be uniquely identified has a Globally Unique Identifier
(GUID), which is used to form unique binding strings. The presence of
this string indicates that the device driver has been bound to a
specific NIC.

Reset

This button resets the statistics in the PC Network Interface window.

Click Close to return to the Advanced tab.
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6. Click the Device Network Interface Details button to review the following

information.
Skatistic:
MAC Address : FU CO4E 17 FFFB
Packets to : #
Packets from #
Retransmitted [ % of All Sent : { 0%
Reported State : V
Devices Detected | Available : 3/0
Qut OF Sequence [ % of all Received f 0%
Maximum - Average Buffer Usage IW
Buffer Allocation Failures : #
Starving Partis) : -
Help | Reset | C|DD$ |
Fields Description

MAC Address is the network (MAC) address of the DeviceMaster that

MAC Address is currently selected. It should match both the MAC address on the
General tab and the MAC address on the physical DeviceMaster.
Packets To is the count of information frames sent to a layer in the
Packets To

device driver and indicates actual data traffic sent.

Packets From

Packets From is the count of information frames received by a layer in
the device driver, and indicates actual data traffic received.

Retransmitted/% All Sent is the percentage of information frames

Eﬁtgi?lstmltted/% requiring retransmission due to network errors. If this value is not
zero, you may have network problems.
Reported State contains a message showing the status of the device
Reported State driver to the selected DeviceMaster.

Devices Detected/

Devices Detected/Available is the number of DeviceMasters found on

Available the network and how many of the DeviceMasters are available.
Out of Sequence/ % of All Received is the percentage of information
(%ugl?fﬁ%i%?fge/ % frames received out of order, possibly due to network errors. If this

value is not zero, you may have network problems.

Maximum Average

Maximum and Average Buffer Usage is the percentage of the network

Buffer Usage buffer used since the driver was loaded.
. Buffer Allocation Failures displays how many times the driver failed to
?;flfe;ejskllocatlon allocate network buffers to the process because there were not enough
u buffers.

If any Buffer Allocation Failure happens, the Starving Port(s) list will
Starving Port(s) include the name of the COM port that could not be serviced

(immediately) because of it.

Reset clears the data values from the fields. and updates the data
Reset displayed in the event that you want review data before the automatic

refresh cycle occurs.

Click Close to return to the Advanced tab.

74 - Troubleshooting and Technical Support

DeviceMaster Driver User Guide: 2000531 Rev. E




Using the Advanced Tab

The following table provides a list of Device Status messages.

Device Status Message

Description

A MAC address has not yet been
specified for this device. Return to
the General tab, configure the device,
and apply the changes.

The driver may have only been configured with an
IP address. The appropriate MAC address must be
input in the MAC field in the General tab so that the
Advanced tab can report DeviceMaster status.

Can't detect any Comtrol devices.
Check Ethernet connectors and
ensure the device is powered on.

Network traffic is being received, but not from a
DeviceMaster. Check the network connections and
verify that the DeviceMaster is powered up.

Can't detect the device with specified
the MAC address on any network.
Verify the MAC address of the unit,
check the Ethernet connectors and
ensure the device is powered on.

Network traffic is being received from a
DeviceMaster, but not the one specified on the
General tab. Check the DeviceMaster to make sure
that you are using the correct MAC address.

Code upload failed due to a timeout
and the driver is attempting to re-
synchronize with the device.

The device driver has not successfully uploaded the
firmware to the assigned DeviceMaster.

Code upload has completed.

The driver has completed uploading the firmware to
the DeviceMaster.

Code upload was restarted after a
timeout.

The firmware upload process failed due to a time-
out. The upload process has been restarted.

Device detected, initializing.

The server has acquired the DeviceMaster and is
downloading the control program. The DeviceMaster
will be available shortly.

Device detected, microcode upload in
progress.

The device driver is attempting to upload the
microcode to the DeviceMaster. This should
complete momentarily.

Device is active and OK, no data
traffic was exchanged since last
inquiry.

The DeviceMaster and ports are operational. There
is currently no active serial traffic.

Device is active and OK.

The DeviceMaster is okay and ready to use.

Device is detected and configured in
the driver, but is not yet assigned to
this server/PC.

Either the DeviceMaster is currently being
controlled by another server or the DeviceMaster
power has been cycled and the DeviceMaster is
waiting for a server to acquire it.

Excess out-of-sequence packets
received. Check for indications of
high network traffic.

Click the PC Network Interface Details button to
review the statistics, which may indicate that
DeviceMaster is functioning properly.

This message typically goes away on it's own but you
can reboot the PC so that the network traffic is re-
synchronized.

Excess packet retransmissions
detected. Check for indications of
high network traffic.

Click the PC Network Interface Details button to
review the statistics, which may indicate that
DeviceMaster is functioning properly. This message
typically goes away on it's own but you can reboot
the PC so that the network traffic is re-
synchronized.

Initialization complete. Waiting on
response from the device before
making the connection active.

Waiting for a response from the DeviceMaster.

Statistical data was reset.

This indicates the number of times that the
statistics in the PC Network Interface and Device
Network Interface have been reset.
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Device Status Message

Description

The driver is not running. If you just
installed the driver you will need to
exit the program before the driver
starts.

Close and then re-open the Comtrol Drivers
Management Console.

The communications between the
driver and the device has been
disrupted. Check connectors, cabling,
and look for indications of high
network traffic.

The DeviceMaster is off-line in this state. The MAC
or IP address for the DeviceMaster is known
(assigned) but communications have been
interrupted.

The device has failed to respond for
an extended period of time. The
device may have lost power or is in
an unresponsive state.

The device driver is no longer able to communicate
with the DeviceMaster. Check the LED status (Page
70).

The driver is not running. Make sure
the driver is installed correctly and
restart the PC to correct the
problem.

Make sure the driver is installed correctly and
restart the PC to correct the problem. The driver is
most likely disabled. Enable the driver and reboot
the PC.

Timeout occurred while the driver
was waiting for an ADMIN command
reply from the device.

There may be network traffic problems, an
unresponsive DeviceMaster, or a problem with the
server sending out network data.

The device driver is trying to locate the
DeviceMaster on the network by sending out the ID
request and not receiving a response from the
DeviceMaster, which may indicate that the
DeviceMaster is either not on the network, on a
different segment (if using MAC mode of
addressing), or the bandwidth of the network (or
server) is so saturated that the DeviceMaster
response is not received in time.

Timeout occurred while the driver
was waiting for an Assign Reply
response from the device prior to
making the connection active.

There may be network traffic problems, an
unresponsive DeviceMaster, or a problem with the
server sending out network data. A handshake that
occurs after an ID response is received and the
device driver is trying to establish a communication
channel with the DeviceMaster.

Unable to find a Network Interface

Install a NIC in that PC or check that the NIC is

Controller (NIC) card. operational.
The firmware has not uploaded to the DeviceMaster.
Uninitialized. If this message is displayed in the History file, it

often means that the DeviceMaster is in the process
of being rebooted.
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NS-Link Driver Troubleshooting

This table includes some tips related to NS-Link drivers.

NS-Link Condition

Explanation/Action

Need to program IP
address into the device.

Before programming an IP address it is critical that the
DeviceMaster be operational and passes the power on tests
when configured for the MAC address.

Note: Ifthe DeviceMaster is NOT operational, do NOT attempt
to program or use an IP address with the DeviceMaster.

See Program the IP Address (Network Information) on Page 13
for more information.

Cannot open port

1. Verify that MAC address in the NS-Link driver matches
the address on the DeviceMaster.

2. Verify that you are using the correct NS-Link driver. If
necessary, remove and reinstall a new driver.

3. Isolate the DeviceMaster from the network (see Page 67).

4. Check to see if another program or computer is active on
this port.

The Comtrol device has a
lower limitation of
network bandwidth
requirement of 64 Kbps.

At this speed the entire available bandwidth is required for the
purpose of uploading the firmware from the driver to the
DeviceMaster. At lower speeds, timing issues will prevent the
firmware from being successfully installed to the
DeviceMaster, thus preventing the DeviceMaster from normal
operation.

When using the DeviceMaster over a WAN link that is less
than the recommended 64 Kbps, a timing modification may be
made that will allow uploading of the firmware.

Load the driver locally to the DeviceMaster for the purpose of
getting the firmware installed. The PC on the other side of the
slow link can then “share” the port. The sharing may be
exclusive as the firmware loader PC may not need to access the
ports.
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Using Port Monitor to Test Ports

This procedure will check whether the DeviceMaster can:

e Communicate through the NS-Link device driver

¢ Determine if a port is open with an application

If necessary, install PortVision DX (Before Installing the Comtrol Drivers
Management Console on Page 9, Page 11).

1.

Open PortVision DX using the desktop shortcut.

2.

Start Port Monitor by clicking Tools > Applications > Port Monitor (PMon2).

1BV PortVision DX =N EoR
File Manage View Help
L] ~ Refiresh All - .
- ¥ ] ﬁ A" =
o Scan Network - e - o
Scan  Refresh tehoat Notes | Help  About  Ext
Check for Updates .
Log File v b ES9528(0/9)
Applications y Customize ..
IPORTVI
Options .. Test Terminal (WCom2)
| Port Menitor (PMen2) 5
HyperTermima e
- Drivers L
Name : First Floor - E
 ESE510
vl v ESBS10-KTE
1 + 10-Link Master #1
/ Modbus/TCP
i * PRO - 17:FFFE
+ RTS_2E - 20:FFFS
Use menu or toolbar to add notes i+ ) RTSA - OT-FFFC
this area. .
sHe
B v UPL5-30VDC
" || @3 Foutth Floor [28/ 20]
Lo T = S SR 52
+|[ & Device Name [ Model 1P Address MAC Address | Software Version [ status
By  Esss ES0528 19216811105 00:CO4E3300:01 114 betod (11030  ON-LINE
L+ 10-Link Master #1 I0-Link Master P-4 19216811199 00:CO4E3%:FFF6  EtherNet/IP 083 ON-LINE
Zl|[mv  ModbusTce UP-1P (5Y) 1921681153  00:COMEAS04TA Modbus/TCP 507 ON-LINE
B o B PRO-17FRFE PRO-8P (DES] 1921681120  00:COMEATFRFB NS-Link 803 ON-LINE
By RTS4-OTFRFC RTS-4P (DBS) 1921681123  00:COEOTFRFC NS-Link9.11 ON-LINE
B RTS2E-20:FRFS RTS-2P (26) 1921681152  00:COAEOFRFS SocketServer9ll ON-LINE
By SH SH-gP (DBS) 1921681114 00:COAEACFRFD NS-Link 911 ON-LINE
B UPLS-30VDC UP-1P (5-301) 1921681155  00:COME2L05:CD Modbus Server 404 ON-LINE
4 " »
First Floor | |1 Ready
3. Click Add Ports using the icon or Tools > Add Ports,
[ Untitled - PMon2 = ]
File Tools Vi e
D& ww BE?
Port Mame | $atus g ports PSR | €O | RTS | DTR [ Actuel Throughput TxTotal RaTotal | Total Eners | OverrunErrors | FramingErrors | ParityErrors
CoM4 CINGED OFF Opf OFF OFF OFF 0 0 0 0 0 0
COMS CLOSPB~aer—TFF OFF OFF OFF 41970289 41966658 O 0 0 0
COME CLOSED OFF OFF OFF OFF OFF 0 ] 0 0 0 0
COMg CLOSED OFF OFF OFF OFF OFF 0 0 0 0 0 0
COMI0  CLOSED OFF OFF OFF OFF OFF 0 0 0 0 0 0
COMIL  CLOSED OFF OFF OFF OFF OFF 0 ] 0 0 0 0
COMI2  CLOSED OFF OFF OFF OFF OFF 0 0 0 0 0 0
COMIS  CLOSED OFF OFF OFF OFF OFF 0 0 0 0 0 0
COMZ5  CLOSED OFF OFF OFF OFF OFF 0 ] 0 0 0 0
COM26  CLOSED OFF OFF OFF OFF OFF 0 0 0 0 0 0
COMIOD  CLOSED OFF OFF OFF OFF OFF 0 0 0 0 0 0
COMIOL  CLOSED OFF OFF OFF OFF OFF 0 ] 0 0 0 0
COMI02  CLOSED OFF OFF OFF OFF OFF 0 0 0 0 0 0
COMI03  CLOSED OFF OFF OFF OFF OFF 0 0 0 0 0 0
COMI04  CLOSED OFF OFF OFF OFF OFF 0 ] 0 0 0 0
COMI05  CLOSED OFF OFF OFF OFF OFF 0 0 0 0 0 0
COMIOS  CLOSED OFF OFF OFF OFF OFF 0 0 0 0 0 0
COMI07  CLOSED OFF OFF OFF OFF OFF 0 ] 0 0 0 0
COMI08  CLOSED OFF OFF OFF OFF OFF 0 0 0 0 0 0
COMI09  CLOSED OFF OFF OFF OFF OFF 0 0 0 0 0 0
< n L3
Add one or more port 1o the list Polling timeris ON NUM
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4. Click Driver, RPSHSI/NSLINK, and click Ok.

Add Ports ... =]

COM1 -

COM2 Cancel
COM3

COm4

COMS

COME

COM?7

COmME

COm3a

0

" Range

Foar example: 3-15.21,45.51-66,74

* Driver
[~ ROCKETPORT INFINITY / EXPRESS
v DEWICEMASTER / MSLINK
[~ ROCKETPORT / ROCKETMODEM
[ WSLIMK

If the DeviceMaster is communicating with the device driver for Windows,
Port Monitor should display CLOSED status. If a port is open for an
application, it displays as OPEN, and displays Actual Throughput, TxTotal and
RxTotal statistics.

L=

File Tools Wiew Help

DS HS v 0F 2

Part Narme | Status | TS I DSk | [l] | RTS | DTR | Actual Throughput | TxTotal | RxTatal | Tatal Errors | CwerrunErrors
COM11 CFEM Loy QR Lo\ Qb eV 114600 [| 205591 209638 ] 1]
COM1z CLOSED |OFF  (OFF  |OFF |OFF |OFF u] 1] u] ] 1]
COM13 CLOSED |OFF (OFF  |OFF |OFF |OFF u] 1] u] ] 1]
COM14 CLOSED OFF  (OFF  |OFF  |JOFF  |OFF u] 1] u] ] 1]
COMIS CLOSED |OFF  |OFF  OFF  (OFF  OFF 0 a a 1] o
COMI1G CLOSED |OFF OFF OFF  OFF  OFF 0 a a 1] 1]
COM17 CLOSED |(OFF |OFF |OFF |OFF |oFF [ u] 1o u] 0 1]
COM15 CLOSED |OFF OFF |OFF |OFF |oFF [ u] 1o u] ] 1]
| | 0
Ready Polling timer is ©Oh MM 4

Normally, there should be no data errors recorded or they should be very
small. To find out what the actual errors are, scroll to the right. You will see
three columns: Overrun Errors, Framing Errors, and Parity Errors.

If the errors are:

Overrun Errors represent receive buffer overflow errors. If this is the case,
you will have to configure either software or hardware handshaking to
control the flow of data. The most common errors are Overrun errors.

Framing Errors indicate that there is an synchronization error between the
beginning of a data frame and the end of the data frame. A frame usually
consists of a start bit, 8 data bits, and a stop bit or two. The framing error
occurs if the stop bit is not detected or it occurs in the wrong time frame.
Most causes for framing errors are electrical noise on the data lines, or
differences in the data clocks of the DeviceMaster and the connected device.

Parity Errors occur when parity is used and the parity bit is not what is
expected. This can also be caused by noise on the data lines.
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6. You can view additional statistics to Port Monitor by adding columns. Click

Tools and Add Columns.

B Untitled - PMon2 i
File | Tools Wiew Help

5

[T

2 0 O 0y 0 [ 5 =

Add Ports
Remave Parts

Remave @Iumns

Reset Yalues
Default Columns

Setkings

=lol x|

B E|?]

| Actual Throughput | TxTotal

| RxTokal

| Tokal Errars | CrverrunErrors

FramingErrars ParityErrors

]

(== | ]| ] | | | ] |

64923300

coooooo

64923300

coooooo

0
1}
1}
0
0
0
0
1}

coooooooo

cooooooo
ocooooooo

7. Highlight or shift-click to add multiple statistics and click OKk.

Add / Remove Columns ...

Flease select the columns ..

ParityE rrars
Statuz Flags
TuPackets
Fi=Packets
TxTatalF aw
Fi=TotalF aw
CvarunE morsHA aw
FramingE rmorzF aw
ParityErmarsRaw
T=CPSInst
R=CPSInzt
T=CPSMinute
RxCPSMinute

o]

fi

Cancel |

|

Note: See the Port Monitor help system if you need an explanation of a

column.
8. Scroll to the right to view the new columns.
File Tools Wiew Help

=]

ST EIEEIER-TE

| RTS | DTR | Actual Throughput | TxTokal | Tokal Errars | CverrunErrars | FramingErrars | ParityErrors | CreerrunErrarsRaw | ParityErrorsR.aw

CFF  OFF ] 64923300 0 1] a 1] u] u]

OFF  OFF 0 a a a a o a % a

OFF _OFF 0 a a a a a a a

QFF  QOFF 1] o] 1] 1] o 1] u] u]

OFF OFF ] a 1] 1] a 1] u] u]

CFF  OFF ] a 1] 1] a 1] u] u]

CFF  OFF ] a 1] 1] a 1] u] u]

OFF  OFF 0 a a 1] a a a a
kil [
Ready Palling kimer is O MM A
9. Ifyou want to capture this session, you can save a current session as a report.

To do this, select one of the following save options:
¢ File > Save As

¢ File > Save - if the report already exists in an older format

e Save Active Session E button

Reports can be opened, viewed and re-used when needed. To open and view a

report:

a. Select File > Open or the Open Existing Session E button. The Open
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Using Test Terminal

Session dialog appears.
b. Locate the session (table), you want to open and click the Open button.

Optionally, if you want to continue monitoring for an existing session, you
need to activate the Polling Interval.

¢ Select Tools > Settings to access the PMon2 Settings dialog
¢ Change the Polling Interval field to a value other than zero (0)

10. Leave Port Monitor open so that you can review events when using Test

Terminal to test a port or ports.

Opening Ports

Test Terminal (WCom2) allows you to open a port, send characters and commands
to the port, and toggle the control signals. This application can be used to
troubleshoot communications on a port-by-port basis.

Send and Receive Test Data: This sends data out the transmit line to the
loopback plug, which has the transmit and receive pins connected thus
sending the data back through the Rx line to Test Terminal, which then
displays the received data in the terminal window for that port. This test is
only testing the Tx and Rx signal lines and nothing else. This test works in
either RS-232 or RS-422 modes as both modes have transmit and receive
capability. A failure in this test will essentially prevent the port from working
in any manner.

Loopback Test: This tests all of the modem control signals such as RTS, DTR,
CTS, DSR, CD, and RI along with the Tx and Rx signals. When a signal is
made HI in one line the corresponding signal line indicates this. The Loopback
Test changes the state of the lines and looks for the corresponding state
change. If it successfully recognizes all of these changes, the port passes.

A failure on this test is not necessarily critical as it will depend on what is
connected and how many signal lines are in use. For example, if you are using
RS-232 in 3-wire mode (Transmit, Receive and Ground) a failure will cause no
discernible issue since the other signals are not being used. If the port is
configured for use as either RS-422 or RS-485 this test will fail and is expected
to fail since RS-422 and RS-485 do not have the modem control signals that
are present in RS-232 for which this test is designed.

The following procedures require a loopback plug to be placed on the port or ports
that you want to test. A loopback plug was shipped with your DeviceMaster. If you
need to build a replacement or additional loopback plugs, refer to the
DeviceMaster Installation and Configuration Guide (Page 7), if you need to build
loopback plugs.

The following procedure shows how to use Test Terminal to send and receive test
data to the serial ports. If necessary, install PortVision DX (Page 11).

1.

2.

Stop all applications that may be accessing the ports such as RRAS or any
faxing, or production software. See the appropriate help systems or manuals
for instructions on stopping these services or applications.

If another application is controlling the port, then Test Terminal will be unable
to open the port and an error message will be shown.

Open PortVision DX using the desktop shortcut.
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Sending and

Receiving Test Data
(RS-232/422 and RS-

485: 4-Wire)

3. Start Test Terminal (WCom2) by clicking Tools > Applications > Test Terminal

(WCom2).
TPV PortVision DX =N o]
File Manage View Help
- ~a Refresh Al — — =
> = ¥ ) ﬁ -
e Scan Network ot w o )
Scan  Refresh o bpage Notes Help  About Exit
Check for Updates ...
Log file b b ES9S28[9/9]
Applications v Customize ...
IPORTVI
Options ... Test Terminal (WCom2) N
| Port Monitor (PMonz2)
HyperTerminal
Drivers L
Name : First Floor - E
B+ Es8510
..... B v ES3510-XTE
..... |+ I0-Link Master 1
B+ Modbus/TCP
ki B v PRO-17:FRFB
----- B RTS.2E - 2:FRFS
Use menu or toobar to add netesin -~ = || B« RTS4 - 07:FRFC
this area. =y
B SHS
B UPLS5-30VDC
i [ [==) Fourth Floor [28 / 29]
— (= co__n__u_ro ram g
+| [~ Device Name [ Model IP Address MAC Address | Software Version [ status
Bv 9528 ES9528 19216811105 00:C04E3300:01 v1d4_betad (b110.3)  ON-LINE
I v I0-link Master #1 10-Link Master EIP-4  192.168.11.199 AE39:FEF6  EtherNet/IP 0,83 ON-LINE
=|[® v Modbus/TCP UP-1P (5¥) 192.168.11.53 Medbus/TCP 5.07 ON-LINE
B+ (& PRO - 1T:FRFB PRO-8P (DB9) 192.168.11.20 NS-Link 8.03 ON-LINE
B RTSE-OT:FRFC RTS-4P (DED) 19216811.23 00 NS-Link 811 ON-LINE
B RTS 2E - 29:FRF5 RTS-2P (2E) 192168.11.52  00:COME29:FFFS SocketServer 911 ON-LINE
Bv  SHB SH-8P (DB9) 192.168.11.14  00:C04E1CFRFD NS-Link 9.11 ON-LINE
B UPL:S5-30VDC UP-1P (5-30V) 1921681155  00:C04E21:05:CD Modbus Server 404 ON-LINE
‘« n 3
First Reserved Application ID for the menu FirstFloor | |1 [Ready

Select File > Open Port, the
appropriate port (or ports)
from the Open Ports drop-

down list and Ok.

Note: Ifyou left Port Monitor
open from the previous
subsection, you should
show that the port is

open.

Go to the next procedure to send
and receive test data. Use the
appropriate procedure:

Sending and Receiving Test
Data (RS-232/422 and RS-

485: 4-Wire) on Page 82

Sending and Receiving Data
(RS-485: 2-Wire) on Page 84

Open Ports ... |

% Select Ports

COvz 2

Cancel

Settings

il

COom3
rokdin LI
" Select Range

For example: 3-15,21,45,51-56,74

You can use this procedure to send and receive test data through the RS-232/422/
485 (4-wire, full-duplex) port or ports that you want to test.

1.
2.

If you have not done so, perform Steps 1 through 3 on Page 81.

Install the loopback plug onto the port (or ports) that you want to test.

See the DeviceMaster Installation and Configuration Guide that you can
download on Page 7, if you need to build loopback plugs.

Select Port > Send and Receive Test Data.
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Loopback Test (RS-232)

You should see the
alphabet scrolling [ wComz - Test Terminal 1ol x|
across the port. If so,
then the port installed
properly and is

File Port Settings  View ‘Window He

| & 3 (& | @ =T ¥

operational. 101
Note: If you left Port BCDEFGHIJKLMNOPQRSTUVW -]
Monitor BCDEFGHIJKLMNOPQRSTUWVWX
running, it BCDEFGHIJKLMNOPQRSTUYWXY
should show BCDEFGHLIKLMNOPQRSTUVWXYZ
data sent and B
received and BC
show the
BCD
average data
BCDE
throughput on BCDEE
the port
port. BCDEFG
4. Select Port > Send and BCDEFGH

I aTalateln'al N1}

Receive Test Data to stop
the scrolling data.

Ready l_ W i

5. You can go to the next
procedure to run the Loopback Test on Page 83 if this is an RS-232 port.

If this test successfully completed, then the port is operational as expected.

Note: Do NOT forget to restart the communications application.

Loopback Test (RS- The Loopback Test tests the modem control (hardware handshaking) signals. It

232) only has meaning in RS-232 mode on serial connector interfaces with full RS-232
signals. If performed under the following conditions, the test will always fail
because full modem control signals are not present:

e RS-422

e RS-485

¢ RJ11 connectors

Use the following steps to run the Loopback Test.

1. If necessary, start Test Terminal (Page 81, Steps 1 through 3).
2. Click Port > Loopback Test.

This is a pass fail test and will take a second or two to complete. Repeat for
each port that needs testing.

If the Loopback Test and the Send and Receive Test Data tests successfully
complete, then the port is operational as expected.
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Sending and Receiving Data (RS-485: 2-Wire)

Sending and This procedure shows how to use Test Terminal (WCom2) to test two RS-485 (2-
Receiving Data (RS- wire, half-duplex) ports.
485: 2-Wire) 1. Start Test Terminal.

2. Open two ports RS-485 ports. This example uses COM40 and COM41.

Fiod example: 3-15.21,4551-56.74

Test Terminal will open two windows, note that both ports show Receiving on
the status bar.

k3 WCom2 - Test Terminal

W COM40

3.

k2 WCom2 - Test Terminal

Fila Port Settings View Window Help
A
M COM40 FBEX = comst

Dizahle Sacadie.

RTS DTR RING Ready
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Sending and Receiving Data (RS-485: 2-Wire)

Both COM ports show Ready on the status bar.

k2 WCom?2 - Test Terminal
Fle Port Settings Yiew Window Help
B 2 & ¢ = F

. COMAO mEE T

4. Right-click in ONE window and select the Receive option from the pop up.
5. Right-click the OPPOSITE window and click Send.

E2 WCom? - Test Terminal EI@IEI
File Port Jettings View ‘Window Help
B & e ¢ o mo ¢

B COM40 CB)X) mcouds

ABCDEFGHIJKLM
ABCDEFGHIJKLMN
ABCDEFGHIJELMNO

ABCDEFGHIJKLMNOP
ABCDEFGHIJELMNOPQ
ABCDEFGHIJELMNOPQR
ABCDEFGHIJKLMNOPQRS
ABCDEFGHIJKLMNOPQRST
ABCDEFGHIJKLMNOPQRSTU
ABCDEFGHII

The Status line shows Sending or Receiving.

In this case, COM40 is sending data and COM41 is receiving the data which is
visually confirmed by the data scrolling across the COM41 window.

Note: If you do not see the data being received it MAY be necessary to also
disable the RTS and DTR options from the right-click pop-up menu in
each COM port.

6. Right-click and remove the check mark on the Sending COM port.
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How Disable/Enable the Device Driver

7. Right-click and remove the check mark on the Receiving COM port.

|EX WComZ - Test Terminal

M COM4

BCDEFGHIJKLMNOPQR
ABCDEFGHIJKLMNOPQRS
ABCDEFGHIJKLMNOPQRST

ABCDEFGHI IABCDEFGHIJKLMNOPQRSTU
ABCDEFGHL ABCDEFGHIJKLMNOPQRSTUY
ABCDEFGHIJK ABCDEFGHIJKLMNOPQRSTUVW
\ABCDEFGHIJKL ABCDEFGHIJKLMNOPQRSTUVWX
ABCDEFGHLJKLM IABCDEFGHIJELMNOPORSTUWVWXY
ABCDEFGHIJKLMN ABCDEFGHIJKELMNOPQRSTUVWAYZ

W

Receiving... = IOPEN Sending. ..

Neither COM port is sending or receiving data but shows Ready on the Status
bar.

8. Reverse the sending/receiving windows one at a time. Set the Receive option
first, then in the opposite window, select the Send option.

The Status line shows Sending or Receiving in the reverse windows.

Data is now scrolling in the COM40 window. COM41 is static as it is not receiving
data but transmitting data.

How Disable/Enable the Device Driver

Use the following procedure to disable or enable the device driver for a specific
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Technical Support

Technical Support

DeviceMaster.

1. Right-click the DeviceMaster that you want to disable (or re-enable).
2. Click Disable (or Enable).

é Comtrol Drivers Management Conscle

- DewiceMaster

[+ REEEh DeviceMaster Serial H
& PRO - Rocket inx Cor
e RocketPort Infinity/Exg

[} B RocketPort EXPRESS,

& DeviceMaster LT, 16 Port
[238 .Y DeviceMaster RTS, 4 [

General | Advanced

Network Connection Mode
[s ) MAC Mode
@) IP Mode

Disable

00 CO 4E 07 FFFC -
Uninstall

192.168.11.23

Properties []Enable SSL Mode

- RocketPort/RocketMoaenr

[ Server Certificate
Client Certificate:

Device Settings

Device Name: DeviceMaster RTS, 4 Port

User-Friendly Device Mame:  DeviceMaster RTS, 4 Port

Verbose EventLog || (Troubleshooting Only)

MNetwork Settings
Reboot Device:

Keep Alive Timeout (seconds): 120 (Default: 120)
TCP Timeout Multiplier: 1 (Default: 1)
Scan Rate (ms): 10 ¥ (Default: 10)
Number of Devices to Load at Once: 20 (Default: 20)
Do NOT Load Firmware to Device |:|

Defaults

Comtrol Drivers Management Console version 2.11
Copyright {C) 2011-2013 Comtrol Corporation.

Save Cunﬁguraﬁoﬂ] [Luad Conﬁguraton] [ QK ] [ Cancel ]

Apply

If you need technical support, contact Comtrol using one of the following methods.

g,;f{fﬁ,‘g Corporate Headquarters
Downloads http://www.comtrol.com/Support

Web site

http://www.comtrol.com

Phone

763.957.6000

CST: 8AM-6PM (Monday through Friday,
excluding major US holidays)
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Technical Support
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Appendix A. Configuring Non-Plug and
Play Devices

After installing the hardware and driver for Windows operating systems, you can
use this discussion to configure non-plug and play COM ports.

Installing Non-Plug and Play Devices

Use the following procedure to install non-plug and play devices.

1. If you have not so yet, connect the device to a DeviceMaster port and turn on
the device.

2. Open the Control Panel.

3. Go to the appropriate subsection to install non-plug and play modems or
printers:

e [nstalling Modems on Page 89
e Installing Printers on Page 90

Installing Modems Use the following procedure to install non-plug and play modems.

1. Ifyou have not done so yet, connect the modem (or modems) to the desired
DeviceMaster port (or ports) and turn on the modem (or modems).

Note: This may take a few minutes, depending upon your system and the
number of modems you are installing.

Open the Control Panel and click the Phone and Modem Options icon.
Click the Modems tab.

Click Add.

Click Don’t detect my modem. I will select it from a list and then click Next.

S

Click an appropriate modem model and then click Next.

Note: If you have a driver from the modem manufacturer, click Have Disk and
browse to the location of the driver. If your modem is not listed, go to the
modem manufacturer’s web site and download the appropriate driver.

7. Highlight the port or ports on to which you have connected modems.
8. Click Finish to complete the modem installation.

9. Configure modem properties as necessary. For assistance, use the Windows
help system.

To use this modem or modems with RRAS, you can refer to the Comtrol RRAS
Configuration Querview for Windows XP document.
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Appendix A. Configuring Non-Plug and Play Devices

Installing Printers Use the following procedure to install a non-plug and play printer.

Note: If you want to install a plug and play printer, connect the printer to the
appropriate serial port and the driver should automatically install. If it
does not automatically install, use the following procedure as a guide with
the printer manufacturers documentation.

Open the Control Panel and click the Printers and Faxes icon.
Click Next when this screen appears.
Click the Local printer attached to this computer item.

Click the COM port that corresponds to the port to which the printer is
connected.

5. Click the Manufacturer, Printer type, and then click Next.

Note: If you have a driver from the printer manufacturer, click Have Disk and
browse to the location of the driver. If your printer is not listed, go to the
printer manufacturer’s web site and download the appropriate driver.

L

Optionally, enter a printer name and then click Next.
Click Yes if you want to print a test page.
Click Finish to complete the installation.

© ©® 3o

Close the Printer and Faxes Control Panel.
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